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Computer Training Center 

هذا الكتيب من ضمن مكتبة شركة باينري سيستمز مصر الخاصة وخاضع لكافة حقوق الملكية الفكرية والإيداع بجمهورية مصر العربية  
HSTC 00A5 Diploma 

Part I :  Introduction &Operating Systems( Windows )
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21 Gamil Ramadan St. Kozzika Metro Station

Cairo, Egypt 

Tel: 2 7005 740   -   Fax: 2 7005740 

www.binaryegypt.com 
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باينري سيستمز  مصر للتدريب وتكنولوجيا المعلومات والإستشارات التكنولوجية 

تعمل بالتعاون مع كبري الشركات العالمية 
( " رؤيتنا " التدريب المزدوج الذي يعتمد علي الربط  بين الواقع العملي  لما  تطلبه الشركات والمؤسسات والبنوك في العالم العربي وبين القدرات الفردية والعمل علي تنميتها من واقع عملي وعلمي مدروس بعنايه فائقة .
( " رسالتنا " التواصل بين المتدرب وما تطلبة الشركات من خلال علاقة الشركة بكلاً منهما في مجالي التدريب والإستشارات والخدمات التكنولوجيه . 
(" هدفنا " تحقيق طموحاتك العلمية وإمداد المورد البشري الكفء لكافة ارجاء الوطن العربي .

( بإلتحاقك بدورات  باينري  : 

· المادة العلمية الكاملة لكل دورة +  عضوية مجانية في المكتبة الإلكترونية 

· شهادة باينري مصر المعتمدة من كبري الشركات العالمية 

· الدعم الفني بكافة الوسائل حتي  بعد إنتهاء الدراسة 

· مساحات مجانية علي Server  الخاص  بالشركة وخدمات أخري * 

· تدريبك بمشاريع واقعية  للشركات + إتاحة الفرصة للتدريب والإحتكاك بواقع العمل 

· مهارات التقدم للوظائف وترشيح سيرتك للشركات المتعاقدة معنا في الخدمات التكنولوجية . 
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Training Diplomas / Courses 

	Basic & Management & Accounting Diploma 

	Fees(L.E) 
	Hr.
	Code
	Name

	160
	24
	GD04
	Basic Diploma ( 4 courses ) 1 Free 

	240
	60
	GD09
	MS office 2003&2007 Diploma ( 6 Courses) 

	280
	84
	GD512
	Advanced G Diploma ( 8 Courses )1 Free 

	240
	48
	A01
	Accounting Diploma ( 6 Courses ) 

	120
	16
	E02
	E- commerce 

	160
	24
	E05
	E-Marketing 

	-
	24
	E03
	E- Business

	180
	24
	M04
	Secretary  Diploma 

	Graphic & Web Design & Multimedia 

	650
	84
	G03
	Graphic Diploma (C9,C26,C19,C15,…) 

	-
	84
	D04
	Multimedia Diploma 

	-
	60
	W02
	Web Design Diploma 

	-
	36
	C9
	Adobe  Photoshop 

	-
	24
	C23
	Adobe Illustrator 

	-
	16
	C24
	Free Hand 

	-
	24
	C26
	Macromedia Flash & Swich max 

	-
	16
	C25
	Corel Draw 

	]- 
	24
	C19
	Dream Waver 

	120
	8
	C15
	SEO

	-
	48
	C20
	3D MAX

	Engineering

	180
	18
	C32
	AutoCAD 2D 

	160
	12
	C33
	AutoCAD 3D

	-
	24
	C35
	SAP 

	120
	16
	C11
	MS Project 

	-
	24
	C36
	Primavera 

	-
	24
	C27
	Mat lab 

	Programming & Database  & Tech. Support

	160
	24
	T02
	PC Maintenance 

	-
	36
	T04
	Networks

	-
	Ask
	P09
	Programming Diploma L1 & L2 & L3  

	-
	Ask
	MC
	VB.net & Java & C & C++ & C# & Java Script 

	
	
	
	SQL & Oracle 10g & PHP & ASP.net

	International Certificates

	175
	48
	
	ICDL 

	-
	60
	
	A+

	-
	Ask
	
	MCSE 

	-
	Ask
	
	MOS 

	-
	Ask
	
	CCNA

	-
	Ask
	
	MCAD 

	www.BinaryEgypt.com
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لقد تغلغل الكمبيوتر في مختلف نواحي الحياة ، حتى بات من نافلة القول أن الأمية لم تعد أمية القراءة والكتابة ، بل صار الجهل باستخدام الكمبيوتر هو الأمية الحقيقية في هذا العصر .

تطلق كلمة الحاسب أو الكمبيوتر على كافة الأحجام والأنواع من الحاسبات الآلية سواء أكان استعمالها للغرض الشخصي أو المنزلي أو أن يكون للاستخدام في مؤسسة أو شركة، أو أن يستخدم لأغراض بعينها في الصناعات الهندسية والطبية والفضائية وغيرها .
تاريخ الحاسبات الشخصية
ظهر أول حاسب آلي في بداية الأربعينات من القرن العشرين ، وكان يتسم بضخامة الحجم والبطء الشديد وكان يحتاج إلى مساحات واسعة وتجهيزات خاصة وكانت إجراءات التعامل معه معقدة تحتاج إلى متخصصين . لكن على مدار الخمسين عاما التي تلت ظهور أول كمبيوتر حدثت تطورات وطفرات ، تمثل أولها في مرحلة الصمامات الزجاجية ، ثم مرحلة الترانزستور الذي تم اختراعه بواسطة معامل شركة بل ؛ مما أدى إلى تخفيض حجم الكمبيوتر وسعره وتكاليف صيانته وتبريده وفي سنة 1981 أنتجت شركة آي بي إم I.B.M  أول جهاز شخصي أطلقت عليه جهاز الكمبيوتر الشخصي من أي بي إم I.B.M Personal Computer  ، وشاع استخدام هذه التسمية حتى أطلقت على كل جهاز كمبيوتر صغير .
 الكمبيوتر يحاكي الإنسان ..كيف ؟...

  ومن واقع دراسة نيومان  نجد أن الإنسان ينقسم وظيفيا إلى الوحدات الأساسية التالية :
  وحدات لإدخال واستقبال المعلومات والبيانات وتتمثل في الحواس الخمس : السمع والبصر والتذوق  والشم واللمس ؛ ووحدة لتخزين البيانات تتمثل في الذاكرة ، ووحدة لمعالجة البيانات وهي العقل، ووحدة إخراج وتنفيذ البيانات وتتمثل في العضلات، والناقلات بين الوحدات وهي الأعصاب .

و لما كانت ذاكرة الإنسان عاجزة عن استيعاب المعلومات والبيانات إلى ما لا نهاية فقد استعان الإنسان بوسائط مساعدة يقوم  بتخزين المعلومات عليها ثم استدعائها في أي وقت ، وذلك  عن طريق أيٍ من وحدات الإدخال الخاصة به ؛ لذلك فقد اختُرع الكتابُ المقروء والصوتُ المسجَّل والفيديو المرئي وغيرها من وسائل حفظ البيانات والمعلومات .
وحدات قياس وتمثيل البيانات
	البت BIT
	 وهو أصغر القيم على الإطلاق وهو يمثل اللغة الثنائيةBinary Number Systems للحاسبات ويتمثل في حالتين فقط 1 أو صفر معبراً عن حالة الدائرة الكهربية في وضع مرور أو في وضع إغلاق.

	البايت BYTE
	 ويتكون من ثمانية بت

	الكيلوبايت KILO BYTE
	 ويتكون من 1024 بايت

	الميجابايت MEGABYTE
	وتتكون من 1024 كيلوبايت

	الجيجابايت GIGABYTE
	وتتكون من 1024 ميجابايت

	التيرابايت TERABYTE
	 وتتكون من 1024 جيجابايت


· Schemas of Study  :- 

· theoretic  part ( Introduction computer )   60 Minutes 
· practical  part I  ( Windows , Desktop and start menu )   3 Hours 
· practical  part II ( Windows , Manage Files )   2 Hours 
· Analysis about Course .
· Quiz and test 

Eng.  Mohammed Gamal


Official Training   
( ما هو الكمبيوتر :- 
عبارة عن جهاز الكتروني يستقبل كم هائل من البيانات Data  باستخدام وحدات الإدخال Inputs  ومن ثم يتم معالجتها عن طريق C.P.U ثم إخراجها عن طريق وحدات الإخراج Output  . 

· استخدامات الكمبيوتر : 
إذا نظرنا للحاسب نظرة فلسفية قليلاً نجد أن الحاسب آلة مثله مثل الكثير من الآلات الأخرى ( التلفزيون ، جهاز استقبال البث الفضائي (الريسيفر) ، الراديو ، الفيديو ....الخ) ولكنه يختلف عن كل الآلات السابقة في فرق جوهري مهم جداً وهو أنه قادر على عمل الكثير من الأشياء المختلفة وليس مخصصاً لعمل شئ واحد ، فالسيارة مثلاً لا تستطيع إلا أن تقودها لتوصيلك من مكان إلى آخر ، كما أن الرسيفر يمكن استخدامه في تلقي البث الفضائي فقط لا غير ، أما بالنسبة للحاسب فإن بإمكانه عمل الكثير من الأشياء المختلفة عن بعضها البعض ، فمثلاً يمكن الحاسب أن يقوم بـــ:
· الحاسبات تستخدم في الحروب : توجيه الصواريخ إلى أهدافها سواء صواريخ أرض أرض أو أرض جو أو غيرها وكذلك حساب مواقع الطائرات بواسطة الرادار 

· الحاسبات تستخدم في الاتصالات : تعتبر الحاسبات جزء لا يتجزأ من مكونات الأقمار الصناعية اللازمة للاتصالات الفضائية. 

· الحاسبات تستخدم في علم الفلك : لحساب مواقع الشهب والنيازك و الوقت المتوقع لوصولها للأرض . 
· حسابات شركتك أو مؤسستك بالكامل مهما كان حجمها 

· مشاهدة التلفزيون والاستماع للراديو و الألعاب و استقبال البث الفضائي ( أي نفس عمل الرسيفر) 
· أن تطبع الرسائل والخطابات و بتصميم وطباعة الرسوم واللوحات الإرشادية
· في مجال الدعاية والإعلان . 
· كما يمكنك القيام بأعمال أكثر تعقيداً مثل الرسم الهندسي الثلاثي الأبعاد 3 D  .
· أن تتصل بشبكة الإنترنت : فتقوم بإرسال واستقبال البريد الإلكتروني وتصفح الوب وتتصل بالآخرين بالصوت والصورة. ويمكنك أيضاً عمل مؤتمرات عن بعد Video Conference 
· في المجال العلمي ( مختبرات تخيلية للواقع لمجالات الكيمياء والفيزياء ) .
· تعلم اللغات والنشر الالكتروني للصحف والمجلات والدرويات العلمية .

[image: image2]
قبل البدء في مكونات الكمبيوتر نتعرف علي أنواع الحاسبات الآلية حسب الحجم لكن نضع في الاعتبار إن المكونات الأساسية ثابتة لكن تختلف في القدرات والوظيفة الأساسية المخصصة لها .
	Table.1 Comparing Computer Types ( Size )

	Computer Type
	Capacity
	Speed
	Typical Cost
	Typical Users

	Mainframe
	Very large
	Very fast
	$1,000,000
	IT departments at major corporations

	Network computer
	Small
	Fast
	$1,000
	Business users

	Personal computer
	Large
	Fast
	$2,500
	Home and business users

	Laptop
	Medium
	Medium
	$4,000
	Business users who travel frequently

	PDA
	Small
	Slow
	$500
	Professionals who need information "on the go"


· التقسيم من حيث الوظيفة الأساسية  : 
	Table 2. Comparing Computer Types ( Function ) 

	و يطلق عليها أيضا الحاسبات القياسية وهذا النوع من الحاسبات يقتصر استخدامه على وظيفة معينة كأن يستخدم في الأجهزة الطبية مثلا لقياس ضغط الدم ، أو رسم القلب ....إلخ .
	ا لحاسبات التطبيقية
 ANALOG CMPUTERS

	 وهذا النوع من الحاسبات هو ما نعرفه ، وهو ما يُستخدم في حياتنا العامة والعملية ، ويتسم بعمومية وتنوع أغراض استخدامه وقدرته على أداء وظائف ونشاطات كثيرة في المجالات العلمية والتجارية وغيرها من المجالات .
	الحاسبات الرقمية
 DIGITAL COMPUTERS


أولا : الأجزاء الصلبة Hardware 

I. وحدة المعالجة المركزية (C.P.U)  CENTRAL PROCESSING UNIT 
تقوم هذه الوحدة بالدور الذي يؤديه العقل للإنسان ، وتتكون من عدد من الوحدات المساعدة لكل منها دوره المكمل للآخر وهي مسئولة بدورها عن استلام الأوامر من وحدات الإدخال عبر النواقل ثم تنفيذها عبر وحدة الحساب والمنطق 

II. وحدات الإخراج  

  تقوم هذه الوحدات بالدور الذي تؤديه العضلات للإنسان ، و وحدات الإخراج متعددة و أهمها الشاشة التي تشبه جهاز التلفزيون ، و كذلك الطابعة التي يتم طباعة النتائج عليها , ومنها السماعات ولوحة الرسام .

1. الشاشات MONITORS

2. الطابعات PRINTERS

3. الراسمات  PLOTTERS
وهناك عدة أنواع من الطابعات ، نذكر منها :
1.  الطابعات النقطية أو الإبرية : DOT MATRIX PRINTERS .

2.  الطابعات التي تعمل بأشعة الليزر : LASER PRINTERS  .

3.  الطابعات نفاثة الحبر : INK JET PRINTERS .
III. وحدات الإدخال: 
وتقوم هذه الوحدات بإدخال النصوص أو الصور أو الصوت من الوسط الخارجي إلي الحاسب الآلي .
1. لوحة المفاتيح KEYBOARD
2. الفأرة MOUSE

3. الماسحات الضوئية SCANNERS
4. القارئ الكودي PARCODE READER
5. القلم الضوئي LIGHT PEN
·     و تتكون لوحة المفاتيح من عدد من المجموعات التالية :

· مفاتيح إدخال الأرقام .   

· مفاتيح لإدخال الحروف الأبجدية .

· مفاتيح التحكم . 

· مفاتيح  قابلة للبرمجة ذات استخدامات خاصة .
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IV. الذاكرة MEMORY
1. الذاكرة الرئيسية MAIN MEMORY  :
· ذاكرة التشغيل العشوائي RANDOM ACCESS MEMORY (RAM) 
تستخدم هذه الذاكرة بواسطة وحدة المعالجة المركزية  في الكتابة والقراءة للبيانات وقت التشغيل حيث يتم تسجيل البيانات والتعامل معها من خلال تقسيمات مكانية داخل الذاكرة كل منها يحمل عنوانا محددا ADDRESS  ، وكلما كان حجم هذه الذاكرة كبيرا أتاح ذلك فرصة لوحدة المعالجة المركزية في سرعة إجراء العمليات المختلفة .

    تجدر الإشارة إلى أن هذا النوع من الذاكرة يفقد محتوياته بمجرد انقطاع التيار الكهربائي عنه أو غلق   الجهاز .

· الذاكرة القاصرة على القراءة فقط READ ONLY MEMORY (ROM) 
حيث لا يمكن أن تتمَّ أيُ كتابةٍ أو إجراء تعديلاتٍ على البياناتِ المخزنة على هذه الذاكرة ، ومن ثم فإن لها استخداما من نوع خاص يتمثل في تخزين التعليمات والبرامج الأساسية التي يتم استدعاؤها بمجرد تشغيل الجهاز ، ولا تتأثر محتويات هذه الذاكرة بانقطاع التيار الكهربي عن الجهاز وهذا عكس الحال فيما يتعلق بذاكرة التشغيل العشوائي  (RAM) .

2 . الذاكرة الثانوية SECONDARY  MEMORY  :
· الأقراص المرنة  FLOPPY DISKS .
  القرص اللين أو المرن هو أحد وسائط تخزين البيانات الممغنطة والأنواع المتاحة من هذه الأقراص هي 12 بوصة ، 5.25 بوصة ، 3.5 بوصة .
· الأقراص الصلبة HARD DISKS  .
  الأقراص الصلبة عبارة عن مجموعة من الأسطوانات المثبتة محورياً ويتخللها عدد من رؤوس القراءة والكتابة والجميع محفوظ داخل صندوق معدني .
· الأقراص المدمجة أو المضغوطة COMPACT DISKS (CD)
  وهي عبارة عن أقراص ذات مواصفات خاصة يتم تسجيل البيانات عليها بواسطة أشعة الليزر وتستطيع استيعاب كميات هائلة من البيانات وهي شائعة الاستخدام ويمكن للأسطوانة الواحدة تخزين نحو ستمائة مليون حرف ويتم تسجيل البيانات عليها مرة واحدة ، وبعد ذلك تستخدم فقط في القراءة لذلك سميت  CD ROM .
	Table 2.2. Comparing Storage Devices

	Storage Device
	Speed
	Cost
	Capacity

	Diskette
	Very slow
	Low
	1.44MB

	Zip disk
	Slow
	Medium 
	100MB250MB

	CD-ROM
	Moderate
	Low
	500MB900MB

	Internal hard disk
	Fast
	High
	40MB1TB

	External hard disk
	Fast
	High
	40MB1TB

	DVD 
	Fast
	Medium 
	4.7GB 18GB



[image: image3]
أولا : أنظمة التشغيلOperating Systems   :- 
هي أنظمة لابد من تواجدها علي جهاز الحاسب الآلي لكي يتم تشغيله وهي تقوم بتنظيم الأعمال بجهاز الحاسب وتتحكم في مكونات الحاسب من وحدات وإخراج وتخزين وهي البيئة الأساسية لعمل أي برنامج أخر علي الجهاز ومن أنظمتها  Dos – Windows – Unix ) ) .
شركة Microsoft  هي من كبري الشركات العالمية في مجال أنتاج البرمجيات خاصاً أنظمة التشغيل DOS ونظام التشغيل Windows  ويمتلك الشركة بيل جيتس  Bill Gates وهو من اغني الشخصيات في العالم وما زالت الشركة تتمتع بالريادة في مجال إنتاج البرمجيات .
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نظام التشغيل Windows   :- 
هو أسهل أنظمة التشغيل في الاستخدام ويحظى بشعبية كبيرة في العالم كله فأكثر من 90 % من مستخدمي الحاسب يستخدمون نظام التشغيل . وكان أول إصدار عام 1993  تحن أسم Windows 3.1 ثم توالت الإصدارات بعد ذلك ( 95 و 98 و ME و 2000 و 2002 (XP) وأخر هذه الإصدارات VISTA 2007 .
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ثانياً  : البرامج التطبيقية Application Programs   :- 
برامج تستخدم في الأعمال المكتبية والشركات يكون غرضها الأساسي هو تطبيقات تتعلق بمجال العمل وتتعدد هذه التطبيقات وتختلف أماكن تشغيلها لك توجد برامج تطبيقية تستخدم غالباً في جميع الأعمال منها مجموعة أوفيس المكتبية والتي تضم أكثر من برنامج منها علي سبيل المثال MS Word وهو برنامج شهير يستخدم في الأعمال المكتبية في معالجة النصوص وكتابة التقارير والرسائل وله استخدامات عديدة . 
Studying Windows 

تشغيل وغلق جهاز الكمبيوتر 
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 يتم تشغيل الجهاز عن طريق مفتاح الطاقة Power Button  والموجودة بصندوق العتاد Case أما عند غلي الجهاز فالطريقة تختلف لأنه يوجد نظام تشغيل OS يقوم بتنظيم عملية الإغلاق حيث يحتفظ بالتغييرات التي تمت علي النظام ويغلق الجهاز بأمان .
1. [image: image172.png]Tooks |

F | speling 7

4] Research. Akecick

% Eror Checking
Shared Workspace.
Shave wWorkook.

r= Protect Workbock.
€1 Protect and share Workbook.



 سطح المكتب Desktop :-
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عند فتح الجهاز تظهر الشاشة الافتتاحية لنظام التشغيل ويبدأ تحميل النظام ثم يظهر بعد ذلك سطح المكتب وهي النافذة الرئيسية لنظام التشغيل ويشتمل سطح المكتب علي ثلاث عناصر رئيسية هما ( الخلفية Background  ، الايكونات Icons  ، شريط المهام Task Bar ) 
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· تغيير الخلفية Chang Background  :
لتغيير الخلفية نضغط R.C  في مكان فارغ بسطح المكتب ثم تظهر Short Menu قائمة مختصرة نختر منها Properties  خصائص بعدها نحدد التبويب أعلي النافذة Desktop  ثم اختيار الخلفية المناسبة من الصور الموجودة أو من Browse  . 
· الايكونات Icons  :
الايكونات هي عبارة عن صور مصغرة تعبر عن ما تحتويه أو تفعله ولابد من معرفة الفرق بين Icon  و Shortcut Icon  و شكل المجلد Folder  وأنواع الملفات المختلفة حيث يختلف شكل الملف حسب ما يحتويه من معلومات . 

	تحتوي علي المستندات التي يتم حفظها عن طريق المستخدم من أي برنامج تطبيقي أو من شبكة الانترنت 
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	تعبر عن أجزاء التخزين الثانوية Hard Disk, CD, Floppy Disk والمستندات 
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	عند الدخول عليها نتصل بالشبكة المحلية LAN والتي تكون متصلة بكافة الأجهزة الاخري في نفس المكان 
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	سلة المهملات ، عند مسح أي مجلد عن طريق المفتاح Delete  يتم نقل ما تم مسحة الي السلة لاحتمال إعادة الملف مرة أخري 
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	مستكشف الانترنت ، هو المستعرض الذي عن طريقه يمكن الدخول علي شبكة الانترنت والدخول علي المواقع والبحث عن معلومات .
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· شريطTask Bar:
عن طريق شريط المهام يمكن فتح قائمة Stat أبدأ وغلق الجهاز أو البحث أو تشغيل البرامج المحملة علي الجهاز ويوجد بشريط المهام الملفات والمجلدات التي يتم فتحها فهي تسهل الانتقال من نافذة إلي أخري بسهولة ويسر ويوجد بالشريط أيضاً الساعة والتاريخ وايكونة الصوت واللغة  .
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· عند تشغيل النوافذ : 
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يوجد بأي نافذة عن تشغيلها مجموعة من الأشرطة الرئيسية وهي كالتالي بالترتيب من أعلي إلي أسفل :

1. شريط العنوان Title bar

2. شريط القوائم Menu Bar
3. شريط الأدوات القياسية Standard Tools Bar

4. شريط العنوان Address Bar

5. شريط المعلومات Status Bar
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· شريط المهام Task bar :-
1. ضبط الوقت والتاريخ Adjust Time and Date :
 انقر D.Click علي الوقت الموجود يمين شريط المهام تظهر نافذة ضبط الوقت والتاريخ أضبط كلاً من :

I. Time 
II. Date
III. Time Zone 

2. [image: image180.png]Format

5 cels.

Row
Column

Sheet

it

21 e

»

»

Autofi
Hde
Urhide,




ضبط حجم الصوت   Sound Volume  :
 بالنقر D.Clicke  علي ايكونة الصوت إذا أردنا التحكم في جميع مداخل ومخارج الصوت وعند النقر S. Click  للتحكم في الصوت ككل بصفة عامة .
3. تحويل لغة المفاتيح English to Arabic  :
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يمكن تحويل اللغة للوحة المفاتيح عن طريق الفارة بالضغط R.C علي ايكونة اللغة بشريط المهام او عن طريق لوحة المفاتيح . 
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Alt + Shift  Arabic To English

Alt + Shift English To Arabic
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قائمة أبــــــــدأ Start Menu  :- 
· Turn Off Computer : 
[image: image10.png]Turn off computer





· Turn Off   إغلاق الحاسب نهائياً   
· Restart      أعادة تشغيل الحاسب مرة أخري
· Standby    جعل الجهاز في وضع استعداد لفترة مؤقتة .  
· Log Off  -  User name  : 
تستخدم للتغيير من مستخدم إلي أخر إذا كان الجهاز يحتوي علي أكثر من مستخدم . Windows Key + L
· Run   : 
لتشغيل ملف أو برنامج أو مجلد أو موقع ويب ، نادراً ما تستخدم قائمة Run حيث يسهل استخدام قائمة Programs  استخدام قائمة Run  حيث تحتوي علي كافة البرامج بمسمياتها دون أدني مجهود لحفظ أسماء البرامج .وفيما يلي بعض الأوامر الهامة :- 
	هي اختصار لأمر Command  وذلك للدخول علي نظام التشغيل DOS
	Cmd 

	اختصارDirectX Diagnostic Tool   للكشف واختبار مكونات الجهاز
	Dxdiag

	تشغيل برنامج معالجة النصوص MS Word
	WinWord

	للتحكم في ملفات الإقلاع في نظام التشغيل
	Msconfig 


· Help and Support : 
تعتبر أداة Help and Support  مصدراً هام للمعلومات عن نظام التشغيل MS Windows  وكذلك تم إضافة الدعم الفني للجهاز والكشف عن مكوناته وإصلاح بعض المشاكل الشائعة في الجهاز . ويمكن البحث عن أي مصطلح أو موضوع عن طريق Index , Search

Start > Help and Support > Support > My Computer Information
· Search  : 
تستخدم قائمة Search  للبحث عن :-
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· Settings أعدادات    : 
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للتحكم في جميع مكونات الجهاز من وحدات إدخال أو أخراج والبرامج وكذلك الشبكة والطابعات والفاكس وشريط المهام وقائمة Start  . 
Control Panel  لوحة التحكم
· استخدامات لوحة التحكم :-
تستخدم لوحة التحكم Control Panel لكي تغير من أعدادات نظام التشغيل و مظهر سطح المكتب ، ولاختيار شاشة توقف مناسبة ولتغيير  الخطوط الافتراضية ، و ضبط الوقت او التاريخ وهكذا وباستخدام لوحة التحكم يمكنك أن تغير من بيئة العمل في ويندوز إلى أي شكل تريده طبقا لإجراءات الضبط
Start > Settings > Control Panel >  KeyBoard , Mouse , Sound , Display , Power Option, System , Regional Language , Task bar and Start menu 

· محتويات  لوحة التحكم:
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تحتوي لوحة التحكم على مجموعة من الرموز التي تمثل البرامج المختلفة التي يمكنك استخدامها في أعمال ضبط الكمبيوتر ،واليك الرموز الشائعة  في لوحة التحكم وهي تشمل :
(1) Accessibility Options خيارات التشغيل :-
  بعض المستخدمين ذوى الاحتياجات الخاصة الذين يعانون من إصابات أو إعاقات معينة تجعل استخدام الكمبيوتر صعبا لذا تتيح لك هذه الخيارات أن تعدل من معدات الكمبيوتر لجعل استخدامه سهلا على سبيل المثال يمكنك أن تضبط سرعة لوحة المفاتيح أو تتجاهل المفاتيح المتكررة أو إصدار أصواتا عندما تضغط مفتاح Caps Lock او Num. Lock او Scroll Lock ويمكنك أن تجعل ويندوز يعرض تحذيرات مرئية بدلا من التحذيرات الصوتية او يعرض نصوصا بدلا من الأصوات او تزيد من تباين الشاشة لتجعل القراءة أسهل او تتحكم في مؤشر الفارة باستخدام مفاتيح الأسهم بدلا من الفأرة .

(2) New Hardware إضافة معدات جديدة  :- 
   يستطيع ويندوز أن يتعرف تلقائيا على المعدات الجديدة التي تضيفها إلى الكمبيوتر هذه الخاصية تسمى (التوصيل والتشغيل) Plug and Play وعندما يفشل ويندوز في التعرف على المعدات الجديدة ، استخدم رمز Add New Hardware لكي يبدأ المعالج الخاص بالبحث عن المعدات الجديدة ويتعرف عليها حتى يتمكن ويندوز من استخدمها بصوره صحيحة .

(3) Add/Remove Programs إضافة / إزالة البرامج :-
يقوم بإعداد او إزالة البرامج بمساعدة البرنامج يمكنك أن تضيف أو تحذف مكونات ويندوز نفسه مثل الألعاب  أو برنامج تليفزيون الموجودة على شبكة الإنترنت ( الويب  (TV web .

(4) Date/Time الوقت/ التاريخ  :-
رغم أن السـاعة الداخلية في الكمبيوتر تحتفظ بالوقت والتـاريخ الحاليين فانك قد تحـتاج في بعض الأحيان إلي ضبطها لتستخدم توقيت منطقه مختلفة أو لتنتقل من التوقيت الشتوي إلى التوقيت الصيفي 

(5) Display مظهر شاشات الويندوز  :-
يستخدم هذا الرمز لإضافة ألوان جديدة لسطح المكتب او لتغيير خلفيته ، وتغيير مظهر النوافذ واستخدام شاشة توقف Screen Saver لحماية شاشة العرض  من الاستهلاك او من التلف.

(6) Fonts  الخطوط :-
  يستخدم هذا الرمز لإضافة خطوط جديدة او إزالة بعض الخطوط القديمة او استعراض الخطوط الموجودة في مجلد الخطوط Fonts ومعرفة خصائصها . 
(7) Keyboard  لوحة المفاتيح :-
   يستخدم لتغيير سرعة تكرار الحروف على لوحة المفاتيح سيؤدي هذا إلى سـرعة او إبطاء ظهـور المفاتيح في البرامج عندما تحتفظ بإحدى المفاتيح مضغوطا . ويمكنك أيضا أن تضبط الفترة الزمنية التي سينتظرها ويندوز قبل أن يبدأ في تكرار المفاتيح . يمكنك أن تستخدم هذا الرمز إذا لاحظت أن الحروف تتكرر بسرعة دون قصد . 

(8) Modem  المودم جهاز موائمة الاتصالات :-
 يستخدم لضبط إعدادات جهاز موائمة الاتصالات المودم لإمكانية تحقيق الاتصال مع شبكة  الإنترنت. 

(9) Mouse الفأرة   :-
  يستخدم هذا الرمز لضبط سرعة مؤشر الفأرة وسرعة النقر المزدوج ويمكنك أيضا أن تستخدمه لتبديل زري الفأرة إذا كنت تستخدمها باليد اليسرى 

(10) Multimedia الوسائط المتعددة :-
    تستخدم لضبط معدات للصوت والصورة في الكمبيوتر يمكنك أن تضبط إعدادات هذه المعدات باستخدام برنامج إعداد الوسائط المتعددة بلوحة التحكم 

(11) User Accounts  حسابا المستخدمين:-
   لإدراج مستخدم أخر للحاسب وتخصيص كلمة سر واختيار صورة مخصصة ومستندات خاصة .
(12) Regional Setting إعدادات إقليميه  :-
يستخدم هذا الأمر لكي يحدد طريقة عرض الأرقام والعملة والتواريخ والوقت . بالنسبة لمعظم المستخدمين  سيكفي ضبط البلد التي يعيشون فيها وسيقوم ويندوز باستخدام الإعدادات المناسبة لهذا البلد ويمكنك أيضا تغيير التاريخ من هجري إلي ميلادي أو إلي أنماط أخري .

(13) Internet شبكة الإنترنت :-
يستخدم هذا الرمز لكي تحدد مكان تخزين الملفات المؤقتة الخاصة بالإنترنت وتحديد إعدادات مجـلد  History وتحديد صفحة البداية وخيارات الأمن وتحديد طريقة الاتصال بالإنترنت والبرامج التي تفضلها 

(14) Sounds  ضبط الأصوات :-
 ضبط الأصوات المختلفة في ويندوز التي تدل على أحداث معينه ويمكنك أن تستخدم هذا الرمز لتحدد الصوت الذي تريد سماعه لكل حدث من هذه الأحداث .

(15) Mail and Fax البريد والفاكس :-
         يستخدم هذا الرمز لكي تقوم بإعداد البريد والفاكس واستخدامهما في إرسال واستقبال الرسائل .

(16) Network شبكة الاتصال:-
  يستخدم هذا الرمز لضبط الإعدادات التي تساعدك على توصيل الكمبيوتر الخاص بك بالشبكة على أن يكون الحاسب مزودا بكارت الشبكة Network Card  .

(17) Telephony الاتصال باستخدام الهاتف :-
 يمكنك أن تدخل الإعدادات المطلوبة لكي تحدد طريقة اتصال جهازك بأشخاص آخرين أو استخدام الحاسب لأجراء الاتصالات التليفونية من خلال المودم وخط التليفون .

(18) Power Management إدارة الطاقة :-
  يستخدم لتضبط ا وتنشئ نظام توفير الطاقة لشاشة الحاسب Monitor والقرص الصلب HD حتى تقلل  من استهلاكهم بدون داع.
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· قائمة البرامج Programs  :-
هي قائمة يوجد بها مجموعة من البرامج سواء كانت التطبيقية او النظامية او الترفيهية منها ما هو تم تحميلة مع الويندوز ومنها يتم تحميله من قبل المستخدم . 
ومن هذه البرامج :
· الآلة الحاسبة Calculator
· الرسام  paint
· معالج النصوص WordPad

· دفتر العناوين Address Book    
· أدوات النظام System Tools
· المفكرة Notepad 

 تشغيل البرامج في ويندوز 
يوفر ويندوز قائمة Start التي تتيح لك أداء كثير من المهام وتستطيع أيضا أن تفتح برامج متنوعة من قائمة Start باختيارك أمر Programs ستتنوع القوائم التي تتفرع من قائمة Programs وفقاً للأعداد الخاص بنظامك .
Start > programs > Accessories > Calculator , Paint , WordPad , Notepad 
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The End 
------------------

Part I of Studying Windows   
Index I 

Translation terminology
	  English 
	Arabic 
	English 
	Arabic 

	Hardware
	الأجزاء الصلبة
	IT
	تكنولوجيا المعلومات

	Software
	البرمجيات
	users
	مستخدمين 

	Network computer
	حاسبات شبكات
	fast
	سريع

	Personal computer
	حاسبات شخصية
	Medium
	وسط

	Laptop
	كمبيوتر محمول
	Slow
	بطئ

	PDA
	حاسب شخصي رقمي
	Appearance 
	المظهر

	ANALOG
	تماثلي
	DIGITAL
	رقمي

	C.P.U
	وحدة المعالجة المركزية
	PLOTTERS
	طابعات خاصة للوحات

	MAIN
	رئيسي 
	RANDOM
	عشوائي

	MEMORY
	ذاكرة
	FLOPPY
	مرن

	COMPACT
	مدمج / مضغوط
	Dos
	Disk Operating System

	Storage 
	تخزين
	Buttons
	أزرار

	Internal
	داخلي
	Background
	خلفية

	External
	خارجي
	Short
	قصير

	Operating
	تشغيل / تهيئة 
	LAN
	Local Area Network

	Database
	قواعد بيانات
	Standard
	قياسي

	Multimedia
	وسائط متعددة 
	Address
	عنوان

	Regional
	إقليمي
	Support
	دعــــم 

	Properties 
	خصائص
	Refresh
	إعادة تأهيل

	Themes
	سمـــــة
	Screen Saver
	شاشة توقف

	Setting 
	أعـــداد
	Browse 
	استعراض

	Customize
	تخصيص
	Local 
	محلي

	View
	عرض
	Favorites 
	مفضلة 

	Help 
	مساعدة
	Add 
	إضافة 

	Details 
	تفاصيل
	Remove
	حذف

	Select 
	تأشير
	R.C
	كليك يمين 


مفاتيح الاختصار الهامة  Shortcut Keys

	المفتاح
	وصفه

	Delete
	حذف ملف أو مجلد أو حرف يمين نقطة الإدراج 

	Backspace
	يحذف الحرف الموجود في يسار نقطة الأدراج 

	Alt + F4
	إغلاق ملف أو مستند أو الجهاز 

	( + D
	أظهار سطح المكتب 

	F1
	فتح قائمة مساعدة ودعم فني Help and Support

	F2
	أعادة تسمية ملف أو مجلد Rename 

	F3
	للبحث عن ملف أو مجلد Search for files or Folders

	F5
	تحديث البيانات Refresh 

	( + R
	فتح قائمة تشغيل Run 

	مفاتيح الأسهم
	تحرك نقطة الأدراج حرفاً واحداً في اتجاه السهم 

	Alt + Shift
	تحويل لغة الإدخال من اللغة  الإنجليزية إلي العربية والعكس  

	Ctrl + W
	إغلاق أي نافذة 

	Ctrl+X
	يقص النص المحدد أو الملف إلي الحافظة 

	Ctrl+C
	ينسخ النص المحدد أو الملف إلي الحافظة 

	Ctrl+V
	يلصق النص الموجود أو الملف من الحافظة 
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Part II: Micrsoft Word 
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21 Gamil Ramadan St. Kozzika Metro Station

Cairo, Egypt 

Tel: 2 7005 740   -   Fax: 2 7005740 
www.binaryegypt.com /hstc00a5 

مقدمة 

مجموعة الاوفيس Microsoft Office package  :- 

من أشهرالبرامج التطبيقة عيل الاطلاق في عالم البرمجيات في العالم كلة قد لاي يخلو اي جهاز حاسب الي من المجموعة حيث تحتوي علي اغلب الببرامج المكتبية والتي لا غتي عنها في اي مكتب . 

أول اصدار للمجموعة من قبل شركة مايكرسوفت العالمية عام 1997 ثم توالت الاصدارات بعد ذلك لنجاح وانتشار المجموعة لسهولة الاستخدام وشمولها علي ما يحتاجة السمتخدم أثناء العمل ... د

أهم الاصدارات  والبرامج التي تشملها :-
	الاصدار  والبرامج التي يشملها الاصدار

	2007

VISTA 
	2003
	2002

XP
	2000
	1997
	MS Word 

	
	
	
	
	
	MS Excel

	
	
	
	
	
	MS PowerPoint

	
	
	
	
	
	MS outlook 

	
	
	
	
	
	MS Access 

	
	
	
	
	
	MS Front Page 

	
	
	
	
	
	MS Publisher 

	
	
	
	
	
	MS One note 

	
	
	
	
	
	MS Project

	
	
	
	
	
	MS Visio

	
	
	
	
	
	MS Info Path ... 

	لكتابة التقارير والمستندات والابحاث واعداد الكتب وتنسيقها قبل الطباعة 
	MS Word 

	يسمي الجداول الاكترونية ويستخدم في العمليات الحسابية واعداد قواعد البيانات الصغيرة 
	MS Excel

	اعداد العروض التقديمية للمنتجات والافكار والمشاريع 
	MS PowerPoint

	تنظيم المواعيد وأستقبال وإرسال البريد الالكتروني 
	MS outlook 

	لانشاء وتنظيم قواعد البيانات Database 
	MS Access 

	تصميم وتطوير مواقع الويب Web Sites 
	MS Front Page 

	يحتوي علي عدد كبير من القوالب الجاهزة للمنشورات والمواقع والمستندات شائعة الاستخدام 
	MS Publisher 

	كتابة الملاحظات والاستفسارات _ منتشر علي الاجهزة المحمولة لرجال الاعمال 
	MS One note 

	تنيظم المشاريع الكبيرة ومن البرامج الشببيى لبرنامج PrimaVira 
	MS Project

	رسم الاشكال التوضيحية والمخططات باحترافية عالية 
	MS Visio

	يوجد برامج اخري سنتكلم عنها لاحقاً 
	Etc.. 


نبذة مختصرة عن وظيفة كل برنامج :

برنامج Microsoft Word  هو أحد برامج مجموعة مايكرسوفت أوفيس ويسمي ايضاً برنامج معالج النصوص ، يعد البرنامج من أهم البرامج الموجودة في المجموعة من حيث كثرة الاستخدام ويعد بمثابة البرنامج الذي يؤهلك للتدريب الجيد علي باقي البرامج لوجود عدد كبير جداص من الاوامر التي تطبق في باقي البرامج ولتشابة القوائم الرئيسية .
الجزء الاول 
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واجهة البرنامج Interface 
1. شريط العنوان Title Bar 

2. شريط القوائم Menu Bar 

3. شريط الادوات القياسية Standard Tools bar 
4. شريط أدوات التنسيق Formatting tools bar 

5. جزء المهام Task pane 

6. الصفجحة الحالية Current page 

7. شريط المعلومات Status bar 
8. المسطرة Ruler 
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لاضافة أو أزالة اي شريط :
من قائمة عرض View اختر أشرطة الادوات Tools bar  وانقر علي الشريط المراد اختيارة أو حذفة 

*يمكنك ايضاً عن طريق النقر R.C كليك لمين علي مكان فارغ بشريط القوائم 

· لإظهار القوائم كاملة دوماً :- 

من شريط القوائم اختر Tools > Customize 
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ثم أختر Always show Full menus 
· طرق اعطاء الاوامر:- 
1. عن طريق القوائم menus 

2. عن طريق الاشرطة Toolbars 

3. عن طريق مفاتيح الاختصار Shortcut keys 

 ( ظبط حجم  الصفحة Zoom  علي  الشاشه 
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من شريط القوائم View > Zoom 

2. [image: image206.png]nzymes are catalysts. Most are proteins. (4 few ribonucleoprotein enzymes have been
discovered and, for some of these, the catalytic activity is in the RNA part rather than the
protein part. Link to discussion of these 1ibozymes )



من شريط الادوات القياسي Standard  اختر 
3. عن طريق النقر مفتاح Ctrl  من لوحة المفاتيح وتحريك  عجلة الماوس 
( ظبط إعدادات الصفة Page Setup 
يمكنك عن ظبط اعدادت الصفحة ظبط الاتي : - 
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أولا : هوامش الصفحةMargins  :- 

هي عبارة  عن المسافات الفارغة التي تترك اعلي واسفل ويمين ويسار الصفحة وغالباً ما تكون ثابتة في كامل المستند ولظبط هوامش الصفحة  أتبع الاتي :-
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ملف File   ( إعداد الصفحة ( هوامش Margins  

يمكنك ظبط الهوامش كما تحب ووضع القيم الذي تريدها مع مراعاة حدود الصفحة والتنسيق الملائم لمستندك والهوامش هي كالاتي ( اعلي – اسفل  ايمن – ايسر ) 

- ويوجد هامش Gutter  ويسمي هامش التوثيق وهو ترك مساحة للتجليد أو التغليف للسمتند 

ثانياً  : إتجاه الورقةOrientation   :- 
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اما ان تكون طولية portrait  أو عرضية landscape  وتختلف حسب تنسيقك للمستند اما عادي او منشور او اعلان عرضي ولا يختلف اذا ما كان ذلك بعد الكتابة والتسيقات او قبل 
ثالثاً : حجم الورقSize  : -
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يتم إختيار مساحة الورق بناءأ علي مساحة الورقة الموجودة  بالطابعة وغالباً ما يكون الورق من النوع A4  الشهير واذا ما احببت تغييرة يمكنك عن طريق القر عيل السهم الموجود بجوار نوع الورق الحالي ويوضح لك كما يف الشكل انه يكتب لك مساحة الورقة بالطول والعرض .

بعض أنواع الورق الشهير 

	W
	H
	Type
	W
	H
	Type

	21.59
	27.94
	Letter
	21 CM
	29.7 CM
	A4

	21.59
	35.56
	Legal
	29.7
	42
	A3


( معرفة خصائص المستند Properties  :-
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لمعرفة خصائص المستند والتي تشمل :-

1. معلومات عامة عن المساحة وتاريخ الانشاء والتعديل والاسم General 
2. معلومات عن الناشر والمؤلف ,اخري
3. إحصائيات عن الوقت المستغرق واخر مرة للطباعة وعدد الكلمات والجمل 
4. عن المحتوي 
5. تخصيص لبعض المعلومات الاخري 
عن طريق 
ملف File  ( خصائص Properties 
الجزء الثاني  

التسيقات Formaating 
أولاً : الــتــأشير 

التأشير من اهم المهارات في اي برنامج كتابي او رسومي وغالباً ما يكون عن طريق الفارة Mouse  ويمكن ايضاً عن طريق لوحة المفايتح باكثر من طريقة . كما يوجد التأشير عن طريق الهوامش    .

(عن طريق الفارة Mouse  :- 
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· عند النقر نقرة واحدة يقف ما بين حرفين او بداية او نهاية الكلمة 
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· عند النقر المزدوج Double Click يتم التأشير علي الكلمة المؤشر عليها   
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عند النقر المزدوج Three  Click يتم التأشير علي الجملة بالكامل 
(عن طريق لوحة المفاتيح Key Board  :- 
	Selection
	Short Cut 

	حرف حرف جهة اليسار
	Shift + (

	حرف حرف جهة اليمين 
	Shift + (

	التأشير كلمة كلمة جهة اليسار 
	Shift + Ctrl + (

	التأشير كلمة كلمة جهة اليمين  
	Shift + Ctrl + (

	من اخر السطر  المؤشر علية الي اولة 
	Shift + Home 

	من بداية اسطر المؤشر علية الي نهاية السطر 
	Shift + End  

	المستند بالكامل Select All 
	Ctrl + A 


ثانياً :- تنسيقات رئيسية 
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( من شريط التسيق  Formatting Toolbar  :-

	الاستخدام 
	Shortcut Key 
	Name 
	Tool 

	نوع الخط
	Ctrl + Shift + F 
	Font Face
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	تكبير حجم الخط 
	Ctrl + < ( د ) 
	Font Size 
	
[image: image13.png]




	تصغير  حجم الخط 
	Ctrl + <  ( ج  )  
	Font Size 
	
[image: image14.png]




	خط عريض
	Ctrl + B 
	Bold 
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	خط مائل 
	Ctrl + I 
	Italic 
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	تسطير 
	Ctrl + U 
	Under line 
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	محاذاه الي اليسار 
	Ctrl + L 
	Align Left 
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	توسيط
	Ctrl + E 
	Center
	
[image: image19.png]




	محاذاة الي اليمين 
	Ctrl + R 
	Align Right 
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	ظبط 
	Ctrl + J 
	Justify 
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	المسافة بين الاسطر
	Ctrl + I 
	Line Spacing
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	اتجاه الكتابة  من اليسار 
	Ctrl + Left Shift  
	Left to Right 
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	اتجاه الكتابة  من اليمين 
	Ctrl + Right Shift  
	Right to Left
	
[image: image24.png]




	تعداد رقمي 
	
	Numbering 
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	تعداد نقطي 
	
	Bullets 
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	زيادة المسافة البادئة 
	
	Indent  Decrees 
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	إنقاص المسافة البادئة 
	
	Indent  increase  
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	لون الخط 
	
	Font Color 
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( من شريط القوائم / قائمة تنسيق Format  :-

1. الخط من قائمة تنسيق Format  ( خط Font 
2. الفقرات Paragraph 
3. التعداد النقطي والرقمي Bullets and Numbering 
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لتغيير شكل التعداد النقطي والرقمي من القائمة ثم اختر الشكل الذي تريده سواء من تعداد نقطي أو رقمي  .. اذا اردت اختيار نماذج اخري للتعداد النقطي والرقمي يمكنك من خلال اختيار تخصيص Customize 

ثالثاً  :- تنسيقات الصفحة والفقرات & paragraphs  Page Formatting  

الصفحة هي العنصر الذي يظهر اناقة وشالكل العام للمستند لذا يتم اضافة بعض التنسيقات له علي حسب الحاجة اليها  والتي تخدم الشكل العام للمستند والتنسيق الملائم له ومن التسيقات ما يلي :-=

1. [image: image220.png]


حدود وتظليل المستندBorders and Shading  :- 
يسمي ايضاً اطار المستند أو برواز الصفحة  ولعمل اطار للصفحة يتبع الاتي 

تنسيق Format  ( Borders and Shading  ( حد الصفحة Page Border 
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بعد الاختيار يمكنك الاختيار ما بين اثنان :-
· Style 
وهو عبارة عن نمط للخط يمكنك تغيير لونه وسمكة كما تحب  كما يمكنك عمل Shade  ظل لهذا الشكل ... 
· Art 
صورة من الصور والاشكال الجاهزة 

( يمكنك اختيار خط افقي بشكل جميل لاي من العناصر التي تريد وضع خط اسفلها وذلك من خلال Horizontal Line 
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حدود وتظليل الفقرات Borders  and Shading  :- 
يمكنك عمل حدود وتظليل للفقرات من خلال نفس الاداة السابقة 

مثال عملي :-

يوجد في بعض الكتب والمراجع جزء من الفقرة مظلل بلون رمادي او لون اخر ومن حول حدود للدلالة علي نظرية علمية أو جزء هام من الفقرة او معلومة او ملحوظة لعمل ذلك أتبع الاتي....

بالتأشير علي  الفقرة ثم اختر من قائمة تنسيق Format  ( حدود وتظليل Borders and shading  ( حدود Borders   ثم Shading 
 من نحن ---------------------------------------------------------------------------------------

فريق من المهندسين  والإستشاريين المتخصصين في مجالات مختلفة، طموحنا وهدفنا أن نساهم في تنمية المجتمع من خلال المشاركة الفعالة في تطوير وتنمية العنصر البشري الذي يشكل أهم عنصر وركيزة لنجاح وتطور أي أسره، منشأة، أو الأمه بأسرها. وذلك من خلال المشاركة الجماعية في تقديم أفضل الحلول الإدارية وبرامج التدريب والإستشارات التي تحقق أهداف عملائنا من الأفراد والقطاعات المختلفة. 


عنهم / 
مسئول التدريب بمركز التدريب بكوتسيكا
[image: image226.png]



3. عمل علامة مائية للمستند أو  خلفية Background :- 
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· تأثيرات التعبئة Fill effects  :- 
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هي من الادوات المميزة للتنسيق داخل البرنامج حيث من خلالها يمكن عمل تدرج للالوان او دمج لونان مع بعض أو اختيار مادة من مواد الطبيعة او اختيار نقش أو صورة ...

· Gradient  تدرج الالوان
· Texture  مادة من مواد الطبيعة 
· Pattern  نقش 
· Picture  صورة 
4. إختيار سمة Themes  :- 
هي تشبة الي حد ما السمة الموجودة  باي اداة تكنولوجية اخري كالموبايل حيث انها تختار لون وتصميم  وتنسيق للكلمات بما يتوافقان مع بعضهما البعض دون اي اختيار من المستخدم ..

تنسيق Format  ( Themes  سمة 

5. تنسيق الفقرات Formatting paragraph  :-
تنسيق الفقرات يشمل أكثر من عنصر سيتم تناولها في الجزء 

[image: image231.png]



· ظبط الفقرة  من خلال الاداة Justify    [image: image30.png]



· ظبط المسافات بين الاسطر Line Spacing  
· تغيير حالة الاحرف Change Case  بالسنبة للغة الانجليزية 
قائمة تنسيق Format  ( تغيير حالة الاحرف Change case  

حيث يتم تحويل  حالة الاحرف من صغيرة الي كبيرة الي جملة 

مفتاحي الاختصار      Shift + F3
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6. لتقسيم الفقرة الي  أعمدة Columns  :- 
من قائمة تنسيق Format  ( أعمدة Columns   ثم اختر عدد الاعمدة والاعدادات التي تريدها 

رسالة الشركة ورؤيتها المستقبلية تحت شعار: "المستقبل وجهتنا"، أخذت شركة باينري على عاتقها مهمة المساهمة في إعداد وتدريب الكوادر المحترفة المؤهلة تأهيلاً عالياً في مجال تقنية المعلومات. بما يحقق رسالته في المساعدة في تحسين المعارف التقنية، وتقديم الدعم الفني وخبرة الكادر والشركة لجميع الهيئات والمؤسسات المهتمة بهذا المجال ،وتتجسد رؤية الشركة في المواظبة على توفير التعليم المميز، والتدريب المتفوق، في حقل الكمبيوتر وتقنية المعلومات بأسعار مدروسة.
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· Right to Left 

يؤشر عليها في حالة اللغة العربية فقط 

· Line Between 
وضع خط فاصل بين الاعمدة 

· Width and Spacing 
السمافة بين الاعمة وعرض كل عمود علي حده 
7. [image: image234.png]


لإسقـــاط الاحرف الاستهلالية Drop cap.:- 
نلاحظ كثيراً في المجلات والابحاث والمنشورات الاجنبية بعض الفقرات الخاص بالموزاضعي يكون او حرف بها أو كلمة كبيرة ومنفصلة عن باقي الفقرات يمكنك عمل ذلك في البنرامج بعد التاشير علي الفقرة المراد تكبير الحرف الاستهلايل بها ...
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Dropped 
الاسقاط بمعدل عدد معينة من الاسطر 

· In Margin 
في الهامش بالكامل 
· Font 
اختيار شكل للخط مختلف عن الفقرة 
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علامات الجدولة Tabs  :- 
يمكنك عن طريق علاماات الجدولة وضع علامات للفقرات بحيث يمكنك الانتقال بسهولة من جزء علي السطر الي جزء اخر يتم تحديدة سابقاً عن طريق وضع علامات الجدولة كما عند كتابتك لبيت شعر او مجموعة من العناصر مرتبة علي عدة عدة صفوف داخل الفقرة الواحدة  .....

(  كما تري في المثال الاتي تم وضع علامات الجدولة علي بعد 6 سم  من بداية الهامش و 12 سم بحيث عند نقرك لمفتاح Tab  تنقل تلقائياً للجزء المراد .....
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9. ظبط المسافات البادئة للفقرات والسطر الاول :- 
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10. رأس وتذييل الصفحة Header and Footer  :- 
هو عبارة عن الجزء العلوي والسفلي في الصفحة ويتميز بان ما يضاف اليه يكون ثابت علي كل الصفحات بالمستند ويمكن وضع شعار الشركة أو المؤسسة التي تعمل بها بالاضافة الي العناوين أو البيانات الرئيسية في اسفل الصفحة كذلك التاريخ والوقت ...

· قائمة View   ( رأس وتذييل الصفحة Header and Footer 
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	الوظيفة 
	Tool 

	أدراج نص تلقائي داخل الجزء المؤشر عليه اعلي أو اسفل الصفحة 
	
[image: image32.png]Ingert AutaText ~





	إداراج رقم الصفحة الحالية Insert Page Number 
	
[image: image33.png]




	إدراج العدد الكلي للصفحات في المستند 
	
[image: image34.png]




	تنسيق رقم الصفحة Format 
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	إدراج التاريخ Insert Date 
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	إدراج الوقت Insert time 
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	إعداد الصفحة Page Setup 
	
[image: image38.png]




	أخفاء النص داخل المستند 
	
[image: image39.png]




	التبديل بين رأس وتذييل الصفحة  
	
[image: image40.png]





رابعـــــــاً   :- إدراج العناصر المختلفة داخل المستند والانتقال بين المستند

2. إدراج فاصل الصفحات Brake  :-
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يمكنك ادراج صفحات جديدة فارغة داخل المستند عن طريق 

قائمة إدراج Insert  ( فاصل صفحات Page Break  
مفتاح الاختصار Ctrl + Enter 

3. الانتقال خلال المستند والفقرات :- 
	الوظيفة
	Shortcut Key
	الوظيفة
	Shortcut Key

	الانتقال الي مكان معين في المستند 
	Ctrl + G 
	بداية السطر
	Home

	
	F5
	نهاية السطر 
	End

	
	Edit ( Go To 
	بداية المستند
	Ctrl + Home

	شاشة لاعلي 
	Page up 
	نهاية المستند
	Ctrl + End

	شاشة لاسفل 
	Page Down 
	الصفحة السابقة 
	Ctrl + Page Up 

	
	
	الصفحة التالية 
	Ctrl + page Down  


4. إدراج أرقام الصفحات Page Numbers  :- 
[image: image240.png]To create a new photo album:

+ From the main menu, select File > New o open
the New Presentation task pane.
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يمكنك إدراج أرقام الصفجحات بسهولة ويسر من خلال قائمة إدراج 
قائمة إدراج Insert  ( أرقام الصفحات Page Numbers 
· Position 
موقع الرقم علي الصفحةTop  أعلي ام اسفل Bottom  الصفحة 

· Alignment
محاذاة الرقم علي اليمين او السوط او اليسار او داخل وخارج الصفحة من جهة الهوامش 

· Format 
تنسيق الارقام ورقم البدء للصفحة لااولي حيث يمكنك البدء من رقم غير رقم واحد ...
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5. إدراج الرموز الخاصة والعلامات Symbols  :- 
عند كتابة المستندات  قد تقابلك بعض الرموز الخاصة الغير موجود علي لوحة المفاتيح  ......

Insert  ( Symbols رموز 

يوجد باسفل النافذة اخر 15 عشر رمز تم استخدامهم ويمكنك عمل إختصار لاي رمز تستخدمة بشكل متكرر .

الرموز تعتبر حروف عادية يمكنك أجراء كافة التسيقات عليها كحجم الخط والالوان ....

6. إدارج الوقت والتاريخ Date and Time  :- 
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+ Select the item you want to animate.

. Click the Add Effect button on the Custom
Animation Pane.

+ From the drop-down menu, select Entrance >
More Effects. This opens the Add Entrance
Effect dialog box which displays the full st of
entrance effects available.

+ To preview an effect, make sure the Preview
Effect box is checked.

Click on different entrance effects to preview them.
When you have decided on the entrance effect
you want, lick OK.




لادراج الوقت والتاريخ من قائمة إدراج ثم قم بتحديد اللغة لامراد ادارج التاريخ بها ثم أختر نوع التقويم سواء كان هجري أو ميلادي أو عربي 
[image: image243.png]To insert sounds from the Clip Organizer:
- From the main menu, select Insert > Movies and
‘Sounds > Sound from Clip Organizer. This
opens the Insert Clip Art Pane displaying sound
resuls.
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[image: image244.png]To insert a movie or animated GIF from the Clip
Organizer:

From the main menu, select Insert > Movies and
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7. إدراج النصوص التلقائية Auto Text  :-
النصوص التلقائية مجموعة من النصوص الشائعة الاستخدام والتي ننهي بها الخطاب ونكتبها علي المستندات ويمكنك أيضاً عمل نصوص تلقائية تناسب شركتك أو مؤسستك ... عن طريق التأشير عيل النص المراد عمل تأثير له ثم اختيار New  أو Alt + F3  ....... 
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8. إدراج الصور Insert Pictures  :-
لإدراج الصور يوجد طيرقتان من شريط أدوات الرسم أو من شريط القوائم Menu Bar  
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من شريط القوائم :-
قائمة Insert  ( Picture  (  From File & Clip art 
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بعد أدراج الصورة باي طريقة يمكنك أجراء بعض التعديلات عليها  وذلك من خلال شريط أدوات الصورة :- 
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	الوظيفة 
	Tool 

	لتحديد مكان الصورة بالنسبة لبقية العناصر الاخري في المستند :-

1. سطري مع النص In line with Text 

2. مربع square 
3. مشدود ( يفضل لسهولة التحكم بالصورة من حيث الحركة ووضعها في وسط الكلام واي مكان أخر ) Tight 
4. خلف النص باعتبار الصورة كعلامة مائية أو خلفية للنص Behind Text 
5. امام النص In front of text 
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	لضغط مساحة الصورة التخزينية بغرض تقليل مساحة الصورة  الكلية Compress 
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	عمل دوران للصورة Rotate 
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	أقتصاص الاجزاء الزائدة من الصورة Crop 
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	الاضاءة وأنظمة الالوان Color 
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	أختيار اطار للصورة Border  ويمكن تغيير لونة واعدادت اخري من شريط الرسم 
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	إرجاع الصورة الي ما كان علية سابقاً 
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بعض التغييرات من شريط الرسم Drawing bar  :- 
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	الوظيفة 
	Tool 

	لون الحدود ويسمي لون خط الرسم لابد من التاشير علي عنصر او رسم به حدود او خطوط ليمكن تغيير اللون Line Border 
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	شكل الخطوط Style 
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	نمط الخطوط المتقطعة dash line 
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	لعمل ظل للصورة او لاي عنصر  رسومي أخر Shadow 
	
[image: image55.png]





9. إدراج الاشكال التوضيحية والمخططات Insert shapes and Diagrams   :-
المخططات جزء هام جداً في اي مستند أو مشروع أو تقدسيم لمجموعة من العناصر ويمكن أدراجها بأكثر من طريقة : 

· قائمة Insert  ( picture  صورة Organization Chart  (   مخطط هيكلي 
· قائمة Insert  ( Diagram  شكل توضيحي 
· [image: image251.png]Favortes
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من شريط الرسم Drawing bar  :-
بعد إدراج المخطط المناسب يظهر لك شريط :- 

[image: image56.png]Insert Shape + Layout = | Select = |




	الوظيفة 
	Tool 

	إدراج عنصار أخري داخل المخطط  
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	تخطيط المخطط 
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	تنسيق تلقائي Auto Format 
	
[image: image59.png]




	وضع المخطط 
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( إدراج الاشكال Insert Auto Shapes  :- 
· قائمة Insert  ( picture  صورة    ( الاشكال التلقائية Auto Shapes   
· من شريط الرسم Drawing Bar  
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( عند رسم اي شكل تلقائي تظهر لك لوحة  قماشية للرسم بداخلها انقر من فضلك Delete  وذلك لاتاحة الرسم لك في اي مكان تشأ 
10. إدراج اشكال الكلمات الفنية Insert Word Art   :-
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قائمة Insert  ( picture  صورة    ( Word Art 
· من شريط الرسم Drawing Bar  
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عند أختيار اي شكل يظهر لك بعد الكتابة شريط لاجراء كافة التغييرات والتحكم في التنسيق :-
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.

	الوظيفة 
	Tool 

	تعديل النص المكتوب   
	
[image: image62.png]Edit Text,





	معرض الاشكال لإختيار شكل اخر Word art Gallery  
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	تنسيق الشكل من حيث الالوان والخطوط Format 
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	أشكال أخري من حيث الدروان او نصف دائري او علي هيئة مثلت تصلح هذه الاشكال لعمل شعار نصي بسيط لاسم شركة أو مشروع معين ....
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خامســـاً :- إجراء التعديلات في المستند  

1. لنسخ أو نقل نص من مكان الي أخر Copy or Cut  :- 
يقابلك أثناء عملك تكرار بعض الجمل لذا تريد نسخها من مكان الي مكان أخر في البدياة نقوم بالتأشير عيل النص المراد نسخة أو نقلة ... ثم الانتقال الي المكان الاخر بالنقر Double Click ولصقة ...

 (لعمل النسخ أو النقل :- 

· [image: image256.png]-]
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من شريط القوائم From Menu Bar  :- 
· من شريط الادوات القياسي Standard 
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( ثم الانتقال الي المكان المراد النقل اليه واختيار الامر لصق paste  باي من الطرق 

	الوظيفة 
	Shortcut Key 
	Tool 

	لنقل نص من مكان الي اخر 
	Ctrl + X 
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	لنسخ النص 
	Ctrl + C
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	للصق النص 
	Ctrl + V
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	لنسخ التنسيق 
	Ctrl + Shift + C 
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2. للبحث عن كلمة واستبدالها Find & Replace   :- 
قد تصاف أثناء عملك انة يوجد خطأ قد  حدث اثناء الكتابه في مصطلح قد تكرر في المستند لاكثر من مرة لذا تتي لك هذه الاداة البحث والاستبدال البحث عن واستبداله ....

· قائمة تحرير Edit  ( البحث أو الاستبدال Find or Replace 
· الاختصارات Ctrl + F & Ctrl +H 
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	الوظيفة 
	Tool 

	أستبدال الكلمة الحالية المؤشر عليها أثناء البحث 
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	استبدال الكل 
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	إيجاد نتيجة البحث التالية 
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3. للتراجع عن اخر امر او اعادته مرة أخري Undo and Redo    :- 
· قائمة تحرير Edit  ( Undo or Redo  
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الاختصارات Ctrl + Z & Ctrl +Y 
· من شريط الادورات القياسي Standard 
4. طرق عرض المستند في البرنامج :- 
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يمكنك تغيير طرق العرض في البرنامج عن طريق قاائمة View  والعرض الشائع والمستخدم دائماً هو تخطيط الطباعة Print layout  ....
· تخطيط عادي Normal 

· تخطيط ويب web Layout 

· تخطيط الطباعة print Layout 

· تخطيط القرءاة Reading Layout 

· تخطيط تفصيلي Outline 

( لإظهار وإخفاء المسطرة Ruler 
من قائمة View  ( مسطرة Ruler 
 (لإظهار وإخفاء خرطية المستند Document map  
من قائمة View  ( Document map 
( لإظهار وإخفاء مصغرات للصفحات داخل المستند  
من قائمة View  ( Thumbnails 
( لتكبير عرض المستند  

من قائمة View  ( ملء الشاشة Full Screen 
سادساً  : إنشاء الجداول ووضع كلمة مرور للمستند 
Creating the Table  :
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From Table Menu Select Insert Then Set Number of columns and Rows you want Create it.

2. [image: image261.png]> .

Fomard



By using drawing Table  
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Delete Key : To clearing contents of Table 
Backspace  Key : To Delete Cells , Columns Or Rows of Table 
· ------------------------------------------------------------------------------------------------------------------------
· لحماية المستند من أي تغييرات لكن السماح بفتح المستند : 
من قائمة أدوات Tools  ثم اختر حماية المستند Protect Document 
· لحماية المستند من الفتح إلا بكلمة مرور : 
من قائمة أدوات Tools  ثم اختيارات Options  ثم اختر أمان Security 

سابعاً   : حفظ وإسترجاع المستندات Save and Open 
( لحفظ الملف لاول مرة :-

    من قائمة ملف File  ( اختر Save as  ثم حدد اسم الملف ومكان الحفظ  
    الاختصار    F12 

( لحفظ التغييرات في الملف :- 

    من قائمة ملف File  ( حفظ Save   
    الاختصار    Ctrl + S 
( لغلق المستند فقط دون البرنامج :- 

    من قائمة ملف File  ( اغلاق Close  
   الاختصار    Ctrl + W & Ctrl + F4
 (لغلق البرنامج بالكامل  :- 

    من قائمة ملف File  (خروج Exit   
   الاختصار Alt + F4 
( لفتح مستند موجود سابقاً :- 

    من قائمة ملف File  ( فتح Open   
الاختصار Ctrl + o 
	الوظيفة 
	Shortcut Key 
	Tool 

	مستند جديد
	Ctrl + N
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	فتح مستند 
	Ctrl + O 
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	حفظ التغييرات 
	Ctrl + S
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	خروج من البرنامج 
	Alt + F4
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	إغلاق المستند 
	Ctrl + F4
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	حفظ باسم جديد
	F12
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ثامناً    : الطباعة Printing  
( أولاً : قبل عملية الطباعة يفضل عمل معاينة قبل الطباعة Print Preview  

· قائمة ملف File  ( معاينة قبل الطباعة Print Preview 
· الاختصار Ctrl + F2

· من شريط الادوات القياسي 
( ثانياً  : الطباعة print  :-

· قائمة ملف File  ( Print طباعة 
· الاختصار Ctrl + P

· من شريط الادوات القياسي 
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	الوظيفة 
	Tool 

	اسم الطابعة التي سيتم الطبع عليها 
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	الورق الذي سيطبع :-

· الكل All

· الصفحة الحالية Current page 

· صفحات محددة مثل من 1-5  أو ( 1,5,9) 
	
[image: image84.png]rage range
©a
O Current page

O Pages:





	عدد النسخ التي ستطبع 
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	ترتيب عميلة الطباعة في حالة أكثر من نسخة Collate  يجمع كل نسخة علي حدة بالترتيب ... 
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	كم ورق سيتم طباعتها في كل ورقة حيث يمكن طباعة اربع ورقات في ورقة واحدة كما يمكن تصغير الورقة الي Scale  مقاس معين ....
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Computer Training Center 

HSTC 00A5 Diploma 

Part III : Micrsoft Excel _ L1 


21 Gamil Ramadan St. Kozzika Metro Station

Cairo, Egypt 

Tel: 2 7005 740   -   Fax: 2 7005740 

www.binaryegypt.com /hstc00a5 

Microsoft Excel 2003



· تعريف البرنامج :-

برامج Excel  واحد من برامج الجداول الحسابية الإلكترونية التي تستخدم أساساً للتعامل مع البيانات الرقمية وإجراء العمليات الحسابية عليها وتحديثها مثل :-


1- إعداد الموازنات التقديرية.

2- مراقبة المبيعات.


3- الوظائف المالية .


4- تمثيل البيانات برسوم بيانية .


5- تنفيذ الأعمال بتلقائية ( المختزلات ) .
· وظائف برنامج Excel  :-

1. التعامل مع صفحة البيانات ( WORKSHEET ) لاستخراج ناتج العمليات الحسابية .

2. القيام بوظيفة إدارة قواعد البيانات .

3. تمثيل البيانات بأشكال متعددة من الرسوم البيانية ( CHARTS ) .

4. استخدام الماكرو(المختزلات) وهو برنامج صغير يستدعى لتنفيذ عملية ما 

5. إمكانية إضافة رسوم بيانية لصفحة البيانات.

· عند انتهائك من هذه المحاضرة تكون قادر علي :-
· معرفة واجهة البرنامج Interface 
· معرفة أهم الأشرطة والأدوات الموجودة بها 
· التعرف علي كتاب العمل 
· إدراج وحذف ورق العمل
· التنسيقات المختلفة لورق العمل 
· إدخال البيانات والتعرف علي بعض المهارات 
· تسمية الخلايا والانتقال بينها 
· كيفية كتابة دالة بشكل صحيح 
· الانتقال بين الخلايا 
· التنسيق التلقائي ( بالمحاضرة ) 
· أدوات التعبئة 
· معرفة وتطبيق بعض الاختصارات الهامة 

1. The Excel 2003 Window (Interface)
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أهم أشرطة الأدوات الموجودة بالبرنامج 

جميع الأوامر بالأشرطة مترجمة في نهاية Sheet  المحاضرة 

	Standard Toolbar Icons

	شريط الأدوات القياسي 
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	Formatting Toolbar Icons
	شريط أدوات التنسيق 

	[image: image91.png]Font
Decrease
Font Bald  Underline Cenbr AlignRight CUTenY S DO s Color

¢\\\}/// < A

il - B z =E T % o W

LTI TR

, Percent Increase
Align  Cener Decrease Increase  Fill Colox
Left and St Decimil njent  pugent

Merge







	Drawing Toolbar Icons
	شريط أدوات الرسم 
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2. تكوين البرنامج  :- 
2.1. المصنف ( كتاب العمل ) Work Book 
هو الوحدة الكلية او اكبر وحدة ملفات يمكن التعامل معها في برنامج الجداول الالكترونية حيث يحتوي بداخلة علي اوراق العمل والتخطيطات البيانية  والمعادلات والقوائم ووحدات الماكرو  والوحدات النمطية .
2.2. أوراق العمل Sheets 
عند فتح البرنامج نري إمامنا كتاب العمل الافتراضي والمنشأ تلقائياً ويسمي Book1 يوجد الاسم في شريط العنوان Title Bar بكتاب العمل ( المصنف ) يوجد 3 ورقات عمل افتراضية أيضا  يمكن زيادتها أو إنقاصها .

2.3. تنسيق  أورق العملFormatting Work Sheets   :-
2.3.1. الإدراج :- من قائمة  إدراج Insert  واختيار ورقة عمل Work sheet  أو كليك يمين  R.C  علي ورقة عمل افتراضية واختيار إدراج 
2.3.2. الحذف :- من قائمة تحرير Edit  واختيار حذف ورقة عمل Delete Work Sheet  أو R.C علي ورقة العمل المراد حذفها واختيار Delete  .
2.3.3. تغيير الاسم : من قائمة تنسيق Format  واختيار ورقة العمل ثم تغيير الاسم 
2.3.4. تغيير لون علامة الجدولة Tab Color  : من قائمة تنسيق ثم ورقة العمل و Tab Color 
2.3.5. خلفية لورقة العمل :-   من تنسيق ثم اختيار ورقة العمل بعدها خلفية .
2.3.6. أخفاء ورقة العمل وإظهارها : من تنسيق واختيار ورقة العمل ثم إظهار وإخفاء . 

2.4. الأعمدة والصفوف Columns & Rows:-
2.4.1. الأعمدة :  يوجد بكل ورقة عمل 256 عمود يتم تسميتهم حسب الحروف الهجائية للغة الانجليزية تبدأ من الحرف A  الي IV  ويمكن الوصول إلي آخر عمود عن طريق ضغط مفتاحي Ctrl  والأسهم حسب الاتجاه .  
2.4.2. الصفوف:  يوجد بكل ورقة عمل 65536 صف   ويمكن الوصول إلي آخر صف عن طريق ضغط مفتاحي Ctrl والأسهم لأسفل .  
2.5. الخلايا وطرق التعامل معها Cells  : 
تقاطع الصف مع العمود يسمي خلية وهي وحدة التعامل الرئيسية في البرنامج والتي من خلالها يمكن إدخال البيانات أو إجراء المعادلات ويوجد بكل ورقة عمل أكثر من 16000000   خلية . لكل خلية أسم يبدأ باسم العمود ورقم الصف مثل B5 العمود B  والصف رقم 5 . 



3. إدخال البيانات:- 
3.1. أنواع البياناتData Types  :- قد تشمل  البيانات المدخلة حروف أو أرقام موجبة أو سالبة وقد تكون تواريخ أو توقيتات أو رموز ولكل نوع من البيانات طريقة إدخال خاصة به . 
3.1.1. إدخال الأرقام : 
بالتأشير علي الخلية  المراد إدخال الرقم بها وكتابة الرقم مباشرتا من لوحة المفاتيح إذا كان الرقم سالب توضع العلامة أولا أو يمكن وضع الرقم ما بين أقواس . 
3.1.2. التواريخ والتوقيت: 
يراعي عند كتابة التاريخ وضع الفواصل ولإدراج تاريخ اليوم ( التاريخ الحالي للجهاز ) عن طريق مفتاحي Ctrl + ; 

إما لإدراج الوقت Time وضع الفاصل وصباحا أو مساءاً  2:45 PM   ، الوقت  الحالي Ctrl + Shift + ; 
3.1.3. الرموز Symbols  :
من قائمة أدراج Insert  واختيار Symbol  ثم التأشير علي الرمز والضغط إدراج .

3.1.4. إدخال النص Text  :
حدد الخلية ثم اكتب للانتقال لما بعدها اضغط المفتاح Tab  وإذا كان للأسفل اضغط Enter 

· خاصية الإكمال التلقائي : 
عند كتابتك لمجموعة من البيانات وكتابة عنصر جديد ( عن البدء بكتابة أول حرف يظهر لك البرنامج الحروف المتبقية بناءا علي ما قمت بكتابته ) .

· أستخدام أمر انتقاء من القائمة : 
عن طريق الضغط مفتاحي Alt  وسهم لأسفل تظهر لك ما كتبته في نفس العمود من قبل يمكنك الاختيار من بين النتائج والضغط مفتاح Enter  لتأكيد اختيارك .

4. تسمية الخلايا والانتقال بينها :- 
تسمي الخلية حسباً لاسم العمود من الأحرف ورقم الصف ويوجد الاسم في شريط المعادلة ( الصيغة )Formula  Bar ومعرفة الاسم هام جداً لإدخال المعادلات وتنظيم العمل .
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للانتقال من خلية إلي أخري يوجد عدة طرق :-
· عن طريق شريط المعادلة 
· من قائمة Edit  ثم الانتقال الي Go To 
· عن طريق مفتاح الاختصار F5
· عن طريق مفتاحي الاختصار Ctrl + G 
5. إدخال المعادلات البسيطة :-
لكتابة معادلة لابد من الشروط الآتية :- 
· كتابة الرمز يساوي = قبل كتابة ي شئ أخر في الخلية التي سيظهر بها الناتج 
· كتابة أسماء الخلايا طبقاً لما تم توضيحه  سابقاً أو التأشير عليها 
· كتابة العلامات الحسابية بدقة دون زيادة أو نقصان.
· الضغط Enter  عند الانتهاء من كتابة المعادلة .
تطبيقات المحاضرة:

يتم من خلال هذا التطبيق التأكيد علي المفاهيم الرئيسية لما تم شرحه خلال هذا الجزء من الدورة ويقوم المتدرب بتطبيق كافة ما سيذكر في التطبيق بنفسه بالإضافة إلي طلب مثال  منه ( لواقع عملة  يطبق أيضا في نفس المحاضرة ومناقشة التطبيق والأخطاء الشائعة التي يقع فيها المتدربون وللمتدرب أحقية نشر تطبيقاته علي منتدى المركز الخاص وموقع الشركة بعد مراجعة المهندس المختص بالتدريب ومسئول التدريب بالفرع والاستفادة من مميزات الدعم الفني من خلال الشبكة الدولية  ،، 

وشكراً ,,, 

مهندس / محمد جمال سليمان 

مسئول التدريب بالشركة  
   A-1التطبيق الأول:- 
فاتورة مبيعات 
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المعادلات : 
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A-2 التطبيق الثاني:- 
	ملسلسل
	اسم الطالب
	التربية الاسلامية 
	اللغة العربية 
	الرياضيات
	العلوم
	الدراسات
	المجموع


	1
	محمد سيد زكي
	 
	 
	 
	 
	 
	 

	2
	محمود محسن
	 
	 
	 
	 
	 
	 

	3
	عادل مبروك
	 
	 
	 
	 
	 
	 


ملحوظة :

لعمل تعبئة تلقائية للأرقام أو للتاريخ :-

1. بعد كتابة الرقم ( 1 ) أفتح قائمة تحرير Edit  ثم اختار Fill اختر بعدهاColumns   . 
2. أو بالنقر علي الرقم الأول 1 ثم السحب مع الضغط مفتاح Ctrl   . 
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لعمل تنسيق تلقائي :- 

التأشير علي الجدول ثم من قائمة تنسيق Format  اختار تنسيق تلقائي واختار التنسيق المناسب .

· التنسيق الشرطي Conditional Formatting  :
يستخدم التنسيق الشرطي في اظهار قيم ونتائج محددة بمعايير مخصصة لاظهارها بلون معين بناءأ علي المعايير التي يتم تحديدها ، مثل تمييز العملاء التي تزيد معاملاتهم عن 10000 الاف جنية خلال العام المنقضي وأعطائهم اللون الاصفر ، وتمييز العملاء ما بين 5000 الي 10000 باللون الاخضر ، والعملاء الاقل من 5000 باللون الاحمر .

نلاحظ ان الشروط المسموح بها فقط ثلاثة في كل عملة تأشير ويمكننا التأشير أكثر من مرة علي نفس مدي البيانات مع مراعاة اضافة بيانات جديدة . ولا يشترط تحديد الرشوط بين قيم محددة قد نقول اكبر من او اقل من او يساوي او لا يساوي ... 

عملي :
قائمة تنسيق Format  <  تنسيق شرطي Conditional Formatting 
	مسلسل 
	اسم العميل 
	2008
	2009

	1
	باينري للتدريب
	6443
	11989

	2
	باينري مصر 
	7624
	3267

	3
	باينري سيستمز 
	9743
	5232
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· اللصق الخاص Paste Special  : 
نعلم من خلال دراسة MS Word  كيفية النسخ واللصق لكن نظراً لتعدد مهام برنامج الجداول الالكترونية MS Excel  توجد اداة اللصق الخاص بشكل متطور حيث من خلالها يمكنك لصق المحتوي دون التنسيق او لصق التنسيق فقط او لصق المعادلة او عمل ارتباط بين الملصوق والمصدر . 

عملي : 

قائمة تحرير Edit  <  Paste Special  لصق خاص 

· تنسيق الخلايا Cells Formatting  : 
تنسيق الخلايا له أهمية كبيرة لاخراج الارقام والنصوص وورقة العمل بشكل عام علي مايرام ، ولا يخدث لبث في شكل العلامات او الارقام او العلامات العشرية كذلك تنسيق الخلايا من حدود والوانها وسمك الحدود كذلك الوان التعبئة ...

عملي :

· قائمة تنسيق Format  <  Cells خلايا 
· كليك يمين Right Click <  تنسيق خلايا Format Cells  

· من لوحة المفاتيح Ctrl+1 
لا بد من التأشير علي الخلية او مجموعة الخلايا Block  قبل الشروع في اي عملة تنسيق من اي نوع ....

	تنسيق الارقام Numbers
	يمكنك اختيار العملة المناسبة Currency  لاظهارها بجوار الرقم المراد تمميزة وكذلك تحديد المنازل العشرية Decimal Places  .

وأختيار تنسيق التاريخ والوقت سواء تمت كتابتة ام كتب بالفعل ليتناسب مع اعداد المستند .

أختيار النسبة المئوية Percentage  قبل الشروع في الكتابة افضل ويسهل عملية تنسيق الارقام العشرية .

	المحاذاة 

Alignment 
	لتوسيط الارقام أفقيا Horizontal  ورأسياً في الخلايا او تغيير زاوية دوران الكلام .

	الخط 

Font 
	مثل الاعدادت الخاريجة علي شريط التنسيق بالاضافة الي التنسيقات التقليدية مثل التي تمت دراستها في معالج النصوص MS Word  . 

	الحدود

Borders 
	عند المعاينة قبل الطباعة بدون اعدادت الطباعة النهائية نلاحظ ان الخطوط الموجودة ما بين الخلايا هي خطوط ارشادية لا تظهر في الطباعة لذا يجب عمل حدود خارجية outline  للجزء المراد طباعته وحدود داخلية Inside  ، وهنا يمكن ان نختار الوان الحدود المناسبة .

	الوان التعبئة 

Patterns 
	لعلم خلفية ملونة للخلايا لتمييزها .

	حماية الخلايا 

Protection 
	لحماية الخلايا من اي تغغيرات لكنها مرتبطة بطيرقة حماية ورقة العمل او كتاب العمل ككل .


· لتجميد الصفوف والاعمدة الرئيسية Freeze Panes  : 
اولا لا بد ان نعلم ان الهدف الرئيسي من تجميد الاعمدة والصفوف هو سهولة الحركة خلال ورقة العمل مع تثبيت العناوين الرئيسية المشتركة أعلي الورقة من الاسم والحقول  الرئيسية التي يتم أدراج البيانات اسفلها 
عملي  :

في البداية نقوم اختيار اداءة Split  من قائمة نوافذ Window  

ثم نقوم  بسحب الشريط الظاهر افقيا وعموديا علي الاجزاء المراد تثبيتها مع مراعاة ان الجزء العلوي والايمن ( في حالة ورقة العمل من اليمين لليسار ) هما اللذان سيتم تثبيتهما .

بعد تحديد الاعمدة او الصفوف نختار من قائمة نوافذ windows  نختار Freeze  Panes  

بعد ذلك نستيطع التحرك في المستند عن طريق الاسهم او عجلة الماوس لنلاحظ ثبات الجزء العلوي المحتوي علي اسماء الحقول الرئيسية ...

· لاخفاء أو الصفوف والاعمدة وورق العمل وكتاب العمل : 
· To hide or show Rows, Columns, Worksheets, Workbook :

	اخفاء الصفوف Rows
	بعد التاشير علي الصف او الصفوف المراد أخفائها ، من قائمة تنسيق ثم أختيار صفوف واختيار اخفاء ، للاظهار مرة أخري قم بالتاشير علي ورقة العمل بالكامل ثم اختر اظهار .

Format > Rows > Hide & unhide 

	اخفاء الأعمدة Columns
	بعد التاشير علي العمود او الأعمدة المراد أخفائها ، من قائمة تنسيق ثم أختيار أعمدة  واختيار اخفاء ، للاظهار مرة أخري قم بالتاشير علي ورقة العمل بالكامل ثم اختر اظهار .

Format > Columns > Hide & unhide

	ورقة العمل Worksheet
	بالفعل انت مؤشر علي ورقة العمل المراد اخفائها طلاما انت تقف عليها ومن ثم اختر 

Format > worksheet > Hide & unhide

	كتاب العمل Workbook
	لاخفاء أو أظهار كتاب عمل 

Window > hide & unhide 
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الحمـايــــة Protection  :
الحماية في الجداول الالكترونية لها عدة مستويات تتيح للمستخدم الاختيار ما بين عدة طرق لحماية المستند الخاص به من عدم فتحة اصلا الا بكلمة مرور او فتحة دون تعديلات مطلقا او فتحة مع السماح للمتسخدمين المصرح لهم بالتعديل في منطقة معينة ....
لاحظ علاقة الخلايا المحمية Locked  بالسماح للمتسخدمين بالتغيير فيها 

	مسلسل
	العنوان
	الطريقة

	1
	حماية كتاب العمل بالكامل من الفتح بكلمة مرور
	Tools > Options > Security 

Enter any password you want to open and confirm it then save the workbook and tray open it again the program required from your  the password word 

	2
	حماية ورقة  العمل من التعديل
	Tools > Protection > Protect Sheet 

Can you allow other users modify some attributes in this sheet by selecting it  you want allowed attributes >

	3
	السماح للمتسخدمين بتحرير نطاق محدد 
	Tools > Protection > All Users to Edit Range





· الفــــرز Sort :- 
 بعد أكتمال كتابة البيانات بورقة العمل وعمل التنسيقات اللازمة وتجهيزها للطباعة قد نحتاج الي فرز البيانات تصاعديا أو تنازليا لعنصر محدد مثل السن للموظفين او المرتبات وقد يكون الفرز لاكثر من عنصر اذا تتطابقت نفس القيم للعنصر الاول . 

عملي :-


من خلال الشريط  القياسي Standard Toolbar  بعد التأشير علي البيانات 

من قائمة بيانات Data  <  Sort  فرز 
Ascending  تصاعدي اي ترتيب اسماء العملاء ابجديا من الالف الي الياء ...

Descending  تنازلي 

نلاحظ في النموذج الظاهر ان اذا ما نشابة اسمين في القائمة طبق الاصل يتم الفرز حسب الاعلي مبيعات سنة 2008 واذا تساوي ايضا يقوم بالفرز علي اعلي مبيعات لسنة 2009 . 

· ربط البيانات ببعضها Data Link   :
مفهوم ربط البيانات هو مفهوم شامل وواسع لكننا نريد ان نلق يالضوء او نلمح لطريق بسطية اخترافية يمكن توظيفها لتسهيل العمل داخل كتاب العمل ( قاعدة البيانات المصغرة لشركة متوسطة ) .

بأفتراض انك تعمل في ورقة عمل رقم (1) وتوجد ارقام يجب نقلها الي ورقة رقم (2) وهذه الارقام متغيرة باستمرار اي انك نقوم بتحديث الارقام في الوقة (1) فيجب عليك تغييرها في الورقة الثانية . لذا نحتاج الي اداة تمكنا من نقل التغير الحادث في الرقم من الورقة الاولي الي الثانية بطؤيقة تلقائية ....


عملي :
انسخ الرقم الموجود في الورقة (1) افتح الورقة رقم (2) حدد المكان المراد اللصق بهثم  اختر لصق خاص Paste Special   ومن ثم اختر Paste link
يوجد طريقة اخري وهو كتابة  علامة يساوي =  في الخلية المراد النقل التلقائي اليها وثم كتابة اسم الخلية وورقة العمل 


المثال السابق يعني ان القيمة موجودة في الخلية E15 في ورقة العمل رقم (3)

Shortcut Key – Microsoft Excel 
	الاختصار
	الوظيفة التي يؤديها

	ENTER
	التنقل من أعلى إلى أسفل داخل النطاق المحدد

	SHIFT+ENTER
	التنقل من أسفل إلى أعلى داخل النطاق المحدد

	PAGE DOWN
	التحرك للأسفل بمقدار شاشة واحدة

	PAGE UP
	التحرك للأعلى بمقدار شاشة واحدة

	CTRL+HOME
	الانتقال إلى بداية ورقة العمل

	ALT+PAGE UP
	التحرك بمقدار شاشة واحدة مقترباً من بدايات الصفوف

	ALT+PAGE DOWN
	التحرك بمقدار شاشة واحدة مبتعداً عن بدايات الصفوف

	CTRL+مفتاح السهم
	للانتقال إلى نهاية منطقة البيانات الحالية حسب اتجاه السهم

	CTRL+PAGE DOWN
	الانتقال إلى الورقة التالية في المصنف

	CTRL+PAGE UP
	الانتقال إلى الورقة السابقة في المصنف

	F6
	التبديل إلى الجزء التالي في ورقة عمل تم تقسيمها


	الاختصار
	الوظيفة التي يؤديها

	SHIFT +مفتاح السهم
	لزيادة التظليل بمقدار خلية حسب اتجاه الأسهم

	SHIFT+CTRL+ مفتاح السهم
	لزيادة التظليل حتى حافة نطاق البيانات حسب اتجاه الأسهم

	SHIFT+CTRL+ HOME
	لزيادة التظليل إلى بداية الورقة

	SHIFT+BAGE UP
	لزيادة التظليل صفحة إلى أعلى

	SHIFT+BAGE DOWN
	لزيادة التظليل صفحة إلى أسفل

	CTRL+مفتاح المسافة
	تحديد العامود بأكمله

	SHIFT+مفتاح المسافة
	تحديد الصف بأكمله

	SHIFT+CTRL+{
	تحديد كافة الخلايا التي تكون طرفاً في صيغة هذه الخلية بصورة مباشرة أو غير مباشرة

	CTRL+}
	تحديد كافة الخلايا التي تكون الخلية طرفاً في صيغهم

	CTRL+A
	تحديد ورقة العمل بأكملها

	SHIFT+CTRL+ PAGE UP
	تحديد الورقة الحالية و السابقة ، لإلغاء تحديد عدة أوراق اضغط علىCTRL+PAGE DOWN

	SHIFT+CTRL+PAGE DOWN
	تحديد الورقة الحالية والتالية  ، لإلغاء تحديد عدة أوراق اضغط علىCTRL+ PAGE UP


	الاختصار
	الوظيفة التي يؤديها

	SHIFT+CTRL+ (علامة زائد)
	إدراج خلايا فارغة

	SHIFT+F11
	إدراج ورقة عمل جديدة

	SHIFT+F3
	عرض مربع الحوار Insert Function 

	CTRL+;
	إدخال التاريخ

	SHIFT+CTRL+:
	إدخال الوقت

	ALT+=
	إدراج صيغة "جمع تلقائي" مع الدالة SUM


	الاختصار
	الوظيفة التي يؤديها

	F2
	تحرير الخلية النشطة

	ALT+ENTER
	بدء سطر جديد في نفس الخلية

	SHIFT+F2
	تحرير تعليق خلية

	ALT+السهم إلى الأسفل
	عرض قائمة منسدلة بالإدخالات الموجودة في العامود الحالي

	CTRL+ALT+SHIFT+F9
	إعادة فحص الصيغ المعتمدة ثم حساب كافة الخلايا الموجودة في كافة المصنفات المفتوحة ، بما في ذلك الخلايا التي لم يتم تحديدها للحساب

	SHIFT+F10
	إظهار قائمة مختصرة بالأوامر المتوفرة

	CTRL+0 (صفر)
	إخفاء الأعمدة المحددة

	SHIFT+CTRL+(
	إظهار أية أعمدة مخفية في التحديد

	CTRL+9
	إخفاء الصفوف المحددة

	SHIFT+CTRL+)
	إظهار أية صفوف مخفية في التحديد


اختصارات أخري يكتبها المتدرب :-
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Computer Training Center 
HSTC 00A5 Diploma 

Part IV : MS Powerpoint  


21 Gamil Ramadan St. Kozzika Metro Station

Cairo, Egypt 

Tel: 2 7005 740   -   Fax: 2 7005740 
www.binaryegypt.com /hstc00a5 

Power Point*
يسمي برنامج العروض التقديمية Presentation وهو برنامج رسومي تستخدم فيه الصور والأفلام والأصوات والإشكال التوضيحية وتأثيرات الحركة لإظهار مشروع أو موضوع ما وإيصاله بشكل مبسط وسهل للمتلقي بعيداً عن التفاصيل وبشكل ممتع وجذاب .

* احد برامج مجموعة أوفيس Microsoft Office

·  لفتح البرنامج:
1. من قائمة Start ثم اختر Programs ثم Microsoft Office ثم أنقر كليك شمال علي MS PowerPoint 2003
2. عن طريق إنشاء اختصار علي سطح المكتب Shortcut Icon  بعد النقر كليك يمين علي البرنامج واختيار Send to 
3. بعمل مفتاح اختصار عن طريق الأمر Properties بعد التأشير علي البرنامج.ثم كتابة المفاتيح أمام Shortcut key 
·  لإنشاء عرض تقديمي جديد Create a New Presentation   :

· طرق العرض The different power point Views  :


· أظهار وإخفاء أشرطة البرنامج Hide and show toolbars  :-
من قائمة View ثم اختر Toolbars أشرطة الأدوات وأنقر كليك شمال علي الشريط الذي تريد إظهاره أو أخفاء وه ن أو بالنقر كليك يمين علي مكان فارغ بشريط القوائم menu bar  ثم الاختيار .

· التعرف علي نافذة البرنامج Interface of program  :-



· لحفظ العرض التقديمي :
من قائمة ملف تم أختر حفظ باسم 

File > Save as
حدد مكان الحفظ ثم حدد نوع الملف الذي تريد الحفظ به 

1. Presentaion ( PPT )

2. PowerPoint Show ( PPS)

3. Web Page ( HTM & HTML )

· لحذف أو تكرار شريحة : 
       من قائمة تحرير Edit > Delete Slide  أو من لوحة المفاتيح انقر Delete 

       من قائمة تحرير Edit > Delete Slide  أو أضغط مفتاحي Ctrl + D
بالنقر Right Click  علي نص  تظهر الأدوات آلاتية 
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أدوات قائمة View 
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أدوات قائمة Insert
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قائمة تنسيق Format
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قائمة عرض الشرائح Slide Show
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تجميع أو فك تجميع كائنات الأشكال, والصور, وWordArt

· لتجميع كائنات الأشكال التلقائية, أو الصور, أو WordArt, حدد العناصر التي تريد تجميعها ثم اضغط على المفاتيح CTRL+SHIFT+G. 

· لفك تجميع مجموعة, حدد المجموعة, ثم اضغط على المفاتيح CTRL+SHIFT+H
إظهار الشبكة أو خطوط الإرشاد أو إخفاؤها
   SHIFT+F9إظهار أو إخفاء الشبكة (شبكة: مجموعة من الخطوط المتقاطعة المستخدمة لمحاذاة الكائنات.)ALT+F9،  إظهار أو إخفاء خطوط الإرشاد (خطوط الإرشاد: خطوط مستقيمة غير مطبوعة، وتكون عمودية وأفقية، تستخدم لمحاذاة الكائنات بطريقة مرئية.)CTRL+G     تغيير إعدادات الشبكة أو خطوط الإرشاد
	Comment _ Arabic
	Function _ English
	Shortcut Key 

	
	Open Exiting pre.
	Ctrl + O

	
	New Pre.
	Ctrl + N

	
	New Slide
	Ctrl +M 

	
	Duplicate Slide
	Ctrl + D 

	
	Slide Show
	F5 

	
	Insert New Shape
	Alt + U 

	
	Apply subscript formatting
	CTRL+EQUAL SIGN

	
	Apply superscript formatting
	CTRL+SHIFT+PLUS SIGN 

	
	Copy formats 
	CTRL+SHIFT+C

	
	Restore
	Alt + F5

	
	Maximize 
	Alt + F10

	
	Show Slide layout 
	Ctrl + N 

	
	Switch between Slides and Outline
	CTRL+SHIFT+TAB

	
	Select All
	Ctrl + A

	
	Insert Hyperlink
	Ctrl + K 

	
	Exit 
	Ctrl + Q

	
	Clear Formatting 
	Ctrl + Space

	
	Zoom Out _ Zoom IN 
	Ctrl + wheel 

	
	Print Preview 
	Ctrl + F2

	
	Print 
	Ctrl + P




تجميع أو فك تجميع كائنات الأشكال, والصور, وWordArt

· لتجميع كائنات الأشكال التلقائية, أو الصور, أو WordArt, حدد العناصر التي تريد تجميعها ثم اضغط على المفاتيح CTRL+SHIFT+G. 

· لفك تجميع مجموعة, حدد المجموعة, ثم اضغط على المفاتيح CTRL+SHIFT+H
إظهار الشبكة أو خطوط الإرشاد أو إخفاؤها
   SHIFT+F9إظهار أو إخفاء الشبكة (شبكة: مجموعة من الخطوط المتقاطعة المستخدمة لمحاذاة الكائنات.)ALT+F9،  إظهار أو إخفاء خطوط الإرشاد (خطوط الإرشاد: خطوط مستقيمة غير مطبوعة، وتكون عمودية وأفقية، تستخدم لمحاذاة الكائنات بطريقة مرئية.)CTRL+G     تغيير إعدادات الشبكة أو خطوط الإرشاد

	Comment _ Arabic
	Function _ English
	Shortcut Key 

	
	Open Exiting pre.
	Ctrl + O

	
	New Pre.
	Ctrl + N

	
	New Slide
	Ctrl +M 

	
	Duplicate Slide
	Ctrl + D 

	
	Slide Show
	F5 

	
	Insert New Shape
	Alt + U 

	
	Apply subscript formatting
	CTRL+EQUAL SIGN

	
	Apply superscript formatting
	CTRL+SHIFT+PLUS SIGN 

	
	Copy formats 
	CTRL+SHIFT+C

	
	Restore
	Alt + F5

	
	Maximize 
	Alt + F10

	
	Show Slide layout 
	Ctrl + N 

	
	Switch between Slides and Outline
	CTRL+SHIFT+TAB

	
	Select All
	Ctrl + A

	
	Insert Hyperlink
	Ctrl + K 

	
	Exit 
	Ctrl + Q

	
	Clear Formatting 
	Ctrl + Space

	
	Zoom Out _ Zoom IN 
	Ctrl + wheel 

	
	Print Preview 
	Ctrl + F2

	
	Print 
	Ctrl + P
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Network Concepts & Internet Applications


مقدمه عن الشبكات :

للتعرف على امكانيات الانترنت ،لابد لنا من القاء نظرة على الشبكات او الاتصالات باعتبارها العمود الفقري ( Backboneاو الوسط الذى يتم فيه تداول المعلومات وكيف تتم عملية الا تصال وكيف تعمل الشبكات واشكالها وانواعها ،واشكال وانواع قنوات الاتصال وطرق وعملية تحويل وارسال البيانات والمعلومات والبرتوكولات المستخدمه التى تحكم الشبكات ومكونات الشبكات .
فمعنى كلمة بروتوكول هو نظام او لغة يفهمها جهاز الكمبيوتر فيه يتبادل الجهاز المرسل او الجهاز المستقبل اشارات تشبه ما نقوله نحن فى الاوساط السياسيه.

تعريف الشبكات :
هو ربط جهازين او اكثرمعا من اجل تبادل المعلومات . سواء كان هذا الجهاز حاسب شخصى اوحاسب مركزى (Main Frame) بالأضافه إلى ما يعرف بالمنافذ او الطرفيات Terminals والاجهزة الاخرى المتخصصه مثل الطابعات وقنوات الادخال والاخراج  . 
 (هذه العمليات تحتاج إلى ثلاث مكونات او ثلاث وحدات هى  :-

1- وحدة الارسال    Sending  Unit 
     وهى المسئوله عن إرسال البيانات والمعلومات إلى الحاسبات الاخرى داخل الشبكه.

2- وحدة الاستقبال Receiving Unit 
     وهى الوحدة المسئولة عن استقبال البيانات والمعلومات والرسائل المرسله من حاسبات وطرفيات آخرى داخل الشبكه او الشيكات المتصله بنفس الشبكه .

3- وسط الاتصال   Transmission Media  
     وهى فى الغالب خط تليفونى او كابل اتصال من نوع معين مسئول عن نقل البيانات       والمعلومات من / إلى الحاسبات المتصله بالشبكه 

تاريخ الشبكات :

   فى عام 1960 تم بناء اول  شبكه فى العالم اسمها saber واستخدمت فى مجال حجز تذاكر الطيران وتم بناؤها عن طريق التعاون الذى تم بين كل من شركة IBM ومؤسسة خطوط الطيران American Air Line  وايضا كان هناك شبكه انشئت فى وزارة الدفاع الامريكيه 1969 تسمى ARPANET والتى انجبت شبكه الانترنت فيما بعد .

انواع الاتصال :

تعددت انواع قنوات الاتصال للعمل على مختلف انواع الشبكات وتعتبر الاسلاك التليفونيه هى اقدم هذه الانواع . ومن الانواع الاخرى اسلاك الكابلات وهى تمثل نقله نوعيه فى تحويل الرسائل بين الشبكات حيث انها تحتوى على أزواج من الاسلاك . وهناك ايضآوسائل آخرى مثل (Microwave) .كذلك الاقمار الصناعيه (Satellites) حيث تعمل على ارتفاعات شاهقه فلا تتآثر بكروية الارض والعوائق التى يمكن ان تعيق عمليات التحويل . إن افضل الانواع المستخدمه كوسائل نقل بيانات هى اشعه الليزر التى تنقل باستخدام ما يعرف بالالياف الضوئيه .
خط المشترك الرقم(Digital Subscriber Line) DSL 

تتميز DSL بتكلفتها المنخفضة بسبب اعتمادها في الأساس على نفس خطوط الهاتف النحاسية المجدولة دون الحاجة لشراء معدات وأسلاك جديدة وتركيبها وصيانتها مع ما يرافق ذلك من جهد وتكلفة في حين أن البدائل المتوفرة من خلال تمديد الألياف البصرية او التكنولوجيا اللاسلكية تحتاج الى بنية تحتية جديدة مما يرفع تكلفتها. 
تعتمد سرعة الخدمة التي يوفرها خط المشترك الرقمي بشكل رئيسي على المسافة بين موقع الخدمة ومقسم شركة الاتصالات، فكلما ازدادت المسافة قلت سرعة نقل المعلومات لدى المستخدم. وتختلف انواع خطوط المشترك الرقمي باختلاف سرعتها، ومن أشهر هذه الأنواع: 

2 - خط المشترك الرقمي غير المتماثل (ADSL): 

يعد هذا أشهر انواع خط المشترك الرقمي وصمم ليعطي سرعة تنزيل (download) اكبر بكثير من سرعة التحميل(upload) لأنه معظم المستخدمين يستغلون اتصالهم بالانترنت لتنزيل المعلومات بشكل اكبر بكثير من تحميل المعلومات. يمكن ان تصل سرعة التنزيل الى 2 ميغابت لكل ثانية بينما تصل سرعة التحميل الى 640 ك.بت/ثانية. ينتشر هذا النوع بين مستخدمي الانترنت في المنازل والمكاتب الصغيرة. 

3 - خط المشترك الرقمي المتماثل(SDSL) : 

ويتميز هذا النوع بأن سرعتي تنزيل وتحميل المعلومات متساويتان، حيث تصل كل منهما الى 2 ميغابت في الثانية. ويكثر استعمال هذا النوع عند الشكرات، والمؤسسات التي تقدم خدماتها من خلال الانترنت حيث سرعة التنزيل والتحميل بنفس الأهمية. 

4 - خط المشترك الرقمي الفائق السرعة(VDSL): 

والذي يتميز بالسرعة العالية جدا والتي يمكن ان تصل الى 56 ميغابت/ثانية. ويمكن استخدامه للبث التلفزيوني العالي الجودة، ونقل الملفات الالكترونية كبيرة الحجم. 

( مميزات استخدام خط المشترك الرقمي: 
1. السرعة تصل الى 48 ميغابت/ثانية، وأكثر. 
2. تكلفة إنشاء النظام قليلة نسبيا، وكذلك التكلفة التشغيلية. 
3. لا يشغل خط الهاتف، فيمكن استخدام الاثنين معاً في الوقت نفسه. 
4. تكلفة تشغيلية قليلة. 
5. خدمة مستمرة دون انقطاع.

( أنواع الشبكات حسب النطاق الجغرافى :

1- الشبكه المحليه Local Area Network وهى الشبكه التى تربط بين عدة حاسبات داخل منطقة جغرافيه ضيقه ( دور من مبنى -او مبنى واحد او عدة مبان متجاورة ) .

2- الشبكه العرضيه  Wide Area Network وهى التى يتم انشاؤها داخل منطقة جغرافيه كبيرة بين عدة مدن فى دولة او بين مجموعة دول .

3- الشبكات المتداخلة Internetworking  وهى عبارة عن ربط بين عدة شبكات وبعضها البعض .

أستخدامات  الانترنت

أصبح من نافلة القول أن الأمية أمية القراءة والكتابة فاليوم ،  أصبح الجميع يستخدمون اجهزة الكمبيوتر بصورة مباشرة او غير مباشرة  فقد حلت محل الالات الكاتبه ،وحلت محل مطابع الرصاص المصهور وحلت تقريبا محل خزائن الملفات بل انها حلت محل رسامى الافلام الكرتونيه فى هوليوود .

ام الان فقد اصبحت اجهزة الكمبيوتر تستخدم لتخزين المعلومات ، تصميم المنتجات تحويل النقود والتحكم بالعمليات الصناعيه وادارة المخازن .

واكثر من ذلك فقد صارت تستخدم فى الاتصالات .ولهذا السبب اصبحت اجهزة الكمبيوتر تعرف بانها تقنيه المعلومات “Information Technology” اما اكبر ادارة للاتصالات واكبر جزء فى تقنيها لمعلومات فى العالم الآن فهى " الانترنت" .

فليست الانترنت شبكه واحده بل عدة شبكات متداخله مع بعضها البعض تجعل اجهزة الكمببوتر الموجودة على هذه الشبكات تتحدث مع بعضها بلغه واحدة مشتركه بينهم . ولايوجد تحكم مركزى فى هذه الشبكه وهذا يعتبر من اهم صفات الانترنت . وهى عبارة عن مجموعه مفككه من ملايين الحاسبات موجودة فى  الاف الاماكن حول العالم ويمكن لمستخدمى هذه الحاسبات استخدام الحاسبات الآخرى للعثور على معلومات او التشارك فى ملفات ولا يهم هنا نوع الكمبيوتر المستخدم وذلك بسبب وجود برتوكولات يمكن ان تحكم عملية التشارك هذه . وبشكل واقعى تخيل مكتب كبير مكون من الآف من اجهزة الحاسب مخزن عليه عشرات التيرا بايت من البيانات ولكنه على عكس المكاتب الآخرى لا توجد له سلطه مركزيه تحكمه ، فالمديرين لهذا المكتب ببساطه 

على ان تقوم اجهزتهم بالتحدث بلغه واحده اى التشارك مع الاخرين من خلال ما يعرف ببرتوكول ضبط # التراسل / برتوكول الانترنت والمشهور فى هذا الوسط .
(Transmission Control protocol/Internet protocol - TCP/IP)
وهذا البرتوكول يسرى علي جميع  اجهزة الحاسب المتصله بتلك الشبكه .

( وفيما يلى بعض المواد الاخرى الموجودة على الانترنت  :-

1) الدخول على كثير من الجامعات فى انحاء العالم 

2) ميدان الاهتمامات العامه 

3) الابحاث الطبيه 

4) مساعدة مباشرة فى معظم شركات الكمبيوتر الكبرى 

5) اخبار السوق فى كثير من البلدان 

6) جرائد مطبوعه الكترونيا ومناقشه لمختلف الموضوعات

7) قاموس مباشر يعرف المصطلحات والآسماء المكتوبه من بدايات الكلمات acronyms

8) التعلم عن بعد في اشهر الجامعات الدولية
9) زيارة شركات ، حكومات ، متاحف ، مدارس ، مدن 
10) البحث في المكتبات 
11) القــــراءة
12) الحصول علي برامج في كافة المجالات 
13) مشاهدة التليفزيون والاستماع الي الموسيقي وبرامج الراديو 
اساليب العنونه فى الانترنت

  كما ان لكل انسان عنوانه البريدى ( مكان اقامته ) الذى يمكن بواسطته الوصول إليه ، فأن الحاسب المتصل بالانترنت يجب أن يكون له عنوان منفرد يتم باستخدامة الاتصال به      والواقع ان نظام الحاسب يقوم اساسآ على العناوين ا لمنفرده (Unique) مثل ارقام التليفونات حيث لا يوجد رقمين متشابهان ففى شبكه الانترنت هناك ما يسمى بالعنوان الالكترونى . وبمجرد معرفة العنوان الالكترونى لشخص يمكنك ارسال بريد الكترونى اليه اونقل ملفات اليه اومنه او اجراء محادثه الكترونيه او الحصول على معلومات عن هذا الشخص . وفى المقابل فانك بمجرد استخدامك للانترنت فانك يجب ان تعطى الناس الاخرين عنوانك الالكترونى ليساعدهم على الاتصال بك . 
فكان لابد من فهم اساليب العنونه فى الانترنت وهذا ما سوف نوضحه .      

العنوان القياسى فى الأنترنت :

 كلمه عنوان (Address) فى الانترنت يقصد بها العنوان الالكترونى وليس العنوان البريدى وجميع العناوين فى الانترنت تتبع شكلآ قياسيآ موحدآ يتكون من الآتى : 

تعريف أو توصيف المستخدم       (User)
الحرف       @ عنوان الحاسب او موقعه 

وذلك بنفس الترتيب الموضح من اليسار إلى اليمين مع ملاحظة أن كل حاسب يجب أن يكون له اسم منفرد .

فمثلا :

 وفى هذة الحاله   (info ) يمثل تعريف المستخدم ( User ) وعنوان الحاسب هو (binaryegypt.com ) وكما يتضح  من المثال السابق انه لاتوجد مسافات خاليه إطلاقا خلال العنوان . 
والجزء من العنوان الذى يلى الحرف @ يسمى ايضا Domain  والمجال فى المثال السابق هو (binaryegypt.com ) فأن الصورة العامه لكتابه العنوان فى الانترنت هى


وكما نعلم أن تعريف المستخدم  ( USERID ) فى ذاته ليس بالضرورة منفردآ (Unique ) فهناك العديد الذى يحملون اسم (el_mohndes ) ولكن مايجب ان بكون منفردآ . هو الدمج بين تعريف المستخدم (USERID ) والمجال (DOMAIN ) . 
فرغم وجود العديد من المستخدمين الذين يحملون الاسم (Info) فأن هناك واحد فقط بهذا الاسم يعمل على حاسب اسم   (binaryegypt.com ) 

والحرف @ ينطق AT  . وبالتالى فأن العنوان يقرأ كالتالى 


وبعد انتشار الشبكات دوليا اصبحت هناك حاجة الى استخدام مجالات قمة اكثر تحديداً . ولذلك تم استخدام نظام جغرافى يتم من خلاله استخدام حرفين يمثلان كل دولة وذلك حسب الجدول التالى فيما عدا العناوين الموجودة فى الولايات المتحدة والتى لا تحتوى على اسم الدولة .
المجال(Domain )
ونلاحظ ان المجال ينقسم إلى مجالات فرعيه 

(sub domains)  .كما ان المجالات الفرعيه (Sub domains)  كل منها منفصل عن الاخر بنقطه . وفى المثال السابق هناك ثلاث مجالات فرعيه (Sub domains)  و هى

ولكى نفهم المجال (Domain) فأننا ننظر إلى المجالات الفرعيه (Subdomains) من اليمين إلى اليسار . و يلاحظ أن الاسم يتم تركيبه بحيث يوضح كل مجال فرعى (Subdomain) معلومه على الحاسب . ويمثل المجال الفرعى فىاقصى اليمين مستوى القمه (Top Level ) والذى يكون اكثر المجالات عموميه (Most General ) وكلما تحركنا إلى اليسار يصبح المجال الفرعى اكثر خصوصيه (More specific) .

وفىالمثال السابق يوضح مستوى القمه (eg) اى ان الحاسب موجود فى جمهورية مصر العربيه والمستوى التالى (edu) اى أن الحاسب يتبع مؤسسة تعليمية  وأخير يوضح المستوى الاخير اسم الحاسب المحدد (Idsc- Information Decision Support Center ) .
ويفضل دائما كتابه العنوان بحروف صغيرة لأن بعض النظم تتعامل مع الحروف الكبيرة بطريقه مختلفه خصوصا مع تعريف  (User ID) .

وبصفه عامة هناك نوعين فى مجال القمه (Top –Level Domain ) نوع قديم تنظيمى 

(Organizational)  ونوع جديد جغرافى (Geographical)  ,والنوع القديم التنظيمى كان مبينآ على نظم العناوين التى كانت موجودة قبل ظهور الشبكات الدوليه وكان متوقعآاستخدامه داخل الولايات المتحده الامريكيه فقط لذلك كان يكفى فيه معرفة التنظيم الذى يتبع له الحاسب وكان موضوعآ على اساس تحديد ثلاثه حروف لكل تنظيم داخل الولايات المتحده الامريكيه والجدول التالى يوضح التنظيمات والاختصارات الخاصه بها .

	Meaning
	domain

	commercial organization

educational institution

government

internal organization

military

networking organization

non – pro fit organization
	com

edu

gov

int

mil

net

org


وبعد انتشار الشبكات دوليا اصبحت هناك حاجة الى استخدام مجالات قمة اكثر تحديداً . ولذلك تم استخدام نظام جغرافى يتم من خلاله استخدام حرفين يمثلان كل دولة وذلك حسب الجدول التالى فيما عدا العناوين الموجودة فى الولايات المتحدة والتى لا تحتوى على اسم الدولة .

	Meanig
	domain

	Canada

Germany

Denmark

Greece

Israel

Egypt

united kingdom
	ca

de

dk

gr

is

eg

uk


العناوين الرقمية : ( IP-ADDRESS )
تم شرح فيما سبق عناوين الانترنت المكونة من مجالات فرعية ( Subdomain ) تحتوى على اسماء حرفيه . ولكن الحاسب عادة يتعامل مع الارقام التى التى تمثل هذه الاسـماء الحرفية . لذلك فمن الممكن كتابـة العناويـن علـى هيئـة أرقــام كالأتى ( 163 . 121 . 52 . 10 ) .

ويتكون العنوان الرقمى من اربع مقاطع كل جزء عبارة عن  8-bit اى ان المجمـوع 32-bit
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أدوات ( Web ) :

· تم إصدار أول برنامج للـوب ( Browser ) فى أو آخر سنه 1993 وكان اسم هذا البرنامج ( Mosaic ) كبرنامـج مجانـى متـاح للجميـع ويقـوم بترجمة لغـة ( HTML ) إلى صفحات ( Web ) جديدة ومتضاعفه
· ومن أشهر ( Web Browsers ) :

1. Internet Explorer 

2. Netscape

3. Mosaic

4. Opera

5. Tango

ولقد تحولت الإنترنت إلى آحدى أهم وسائل نشر المنج المعلوماتى بصورة اقتصاديه وقد فرضت سيطرتها على قطاع المال والأعمال والصناعة والخدمات والتعليم والقطاع المنزلي أيضا مما تقدم من برنامج خدماتيه وترفيهية .

مستعرض الإنترنت Internet Explorer 

Open a web Browsing Applications  


لفتح مستعرض الانترنت بالنقر Double Click  علي ايكونة Internet explorer  الموجودة علي سطح المكتب Desktop   ليظهر لك مستعرض الانترنت الاكثر شهرة في العالم  والذي انتجتة شركة Microsoft  وملحق بمكونات الويندوز .


وفيما يلي شرح للأيكونات Icons  الموجودة بشريط الادوات : 


للوصول الي الصفحة السابقة التي قمت بزيارتها . 

لعرض الصفحة التالية والتي تم الانتقال منها الي السابقة  .

لأيقاف تحميل الصفحة علي الشاشة قد تواجهك هذه المشكلة في بعض المواقع التي يتم تحميلها في فترة طويلة  وتريد ايقاف التحميل .

لاعادة تحميل الصفحة مرة اخري في حالة نقص جزء منها اثناء التحميل مثل 
صورة .

 للوصول الي الصفحة الرئيسية وسيتم تعيينها عند دراسة محركات البحث .

بها المواقع التي قمت بتسجيلها في قائمة Favorites والتي تعتاد الدخول عليها.

لطباعة الصفحة الحالية من الموقع واذا كان يتكون من أطارات يتم تقسيم الصفحة الي    مجموعة من المقاطع يحددها الموقع حسب  الورق الذي تطبع علية .


Web Server & Client 
تخزن معظم تامعلومات التي نقوم بالتعامل معها علي الانترنت علي خادم الويب Server ويمكن أن يكون الخادم اي نوع من الحواسب ، ولذي يجعله خادم هو الدور الذي يلعبة في تخزين المعلومات كي يتم استخدامها من قبل العميل Client  ، وهو البرنامج الذي له القدرة علي الاتصال بالانترنت والتخزين او الاستعراض من خادم معين مثل اتصالك ببرنامج معين ( عميل ) Web Browser  متصفح الويب والذي يمكن من خلاله الاتصال بخادم الويب Web server  والذي يحتوي علي صفحات ويب Web Pages  .

Web site & Web pages 
إن موقع ا لويب web site  هو عبارة عن خادم الويب web server ويحتوي علي مجموعة من صفحات الويب web pages  متعلقة بمنظمة أو موضوع معين وعندما نستخدم برنامج متصفح الانترنت web browser للاتصال بخادم الويب الذي تم الاتصال به والمعلومات التي يتم عرضها علي الشاشة يطلق عليها  صفحة ويب Web Pages  . 

ويلاحظ ان كلمة web تستخدم بدلا من شبكة الانترنت علي اساس انها شئ واحد الا ان الويب هو جزء من شبكة الانترنت .

التصفح في صفحات الويب

من الملاحظات الهامة  ان  السبب الرئيسي للدخول علي الانترنت هو استخدام الويب حيث الحصول علي المعرفة الجادة وان كان ينافسها الدردشة والمراسلة لكن اري الجزء الاكبر من المستخدمين الجادين  في استخدام الانترنت هو الدخول علي صفحات الويب للحصول علي معلومات وتقارير واحصائيات تخص مجال العمل او الدراسة كذلك الدخول لقراءة الاخبار خاصتاً انها وسيلة زهيدة الثمن  ، ومن هنا يأتي التطبيق العملي للتدريب  علي كيفية الحصول علي اقصي استفادة ممكنة من الانترنت .

لقد تعرفنا في السابق علي الفرق بين مصطلح ويب web pages وموقع web site  نري الان عن فتحك لنافذة Internet Explorer   ظهور الصفحة الرئيسية Home Page  يتم تخصيصها من قبل المستخدم وتسمي ايضا start up page وغالباً ما تقوم الشركات بتحديد الصفحة الرئيسية علي حسب استفادتها فشركة Microsoft  بما اننا نستخدم متصفح الانترنت التي انشأته في نظام تشغيلها فأن اول صفحة تراها هي www.msn.com   والذي يعني Microsoft Server Network  واذا ما كانت خدمة الانترنت خاصة بشركة او منظمة فأنك تري الموقع الذي حددته الشركة فمثلا السفارة الامريكية بالقاهرة اذا دخلت علي الانترنت تجد انك تجد موقع السفارة بالقاهرة ،، وايضا مكتبة مبارك العامة www.mpl.org.eg   تجد الصفحة الرئيسية الخاصة بها . 
للدخول علي موقع في شريط العنوان Address Bar  اكتب اسم الموقع الذي تريد الدخول علية واضغط المفتاح Enter  أو انقر Go  من نفس الشريط .

تعيين الصفحة الرئيسية

اذا كنت تعمل في شركة او مركز بحثي يجب عليك تعيين الموقع  الخاص بمؤسستك كصفحة رئيسية ، وان لم يكن فيجب عليك تعيين صفحة عند دخولك علي متصفح الانترنت تجدها امامك .

( عملي : 

أفتح قائمة Toolsمن شريط القوائم Menu Bar  الموجود بمتصفح الانترنت Internet Explorer   ثم اختار Option  Internet   وامام Home Page  اكتب اسم الموقع الذي تريده وليكن محرك البحث www.google.com  والذي سيتم التعرف عليه بالتفصيل فيما بعد .

عند فتحك للصفحة الرئيسية تظهر لك الروابط Links  
Link( رابطة او وصله: 

هي عارة عن كلام اوصورة او رمز عن التأشير عليعه يتم نقلك الي صفحة اخري او الي مكان في نفس الصفحة الحالية او يفتح ملف صوت او فيديو او يتم التحميل Download  .
تصفح بعض مواقع الانترنت التي تسمع عنها او استعن بالجدول الاتي ومن خلال التصفح انقر علي الروابط Hyperlink  للانتقال خلال صفحات الموقع المختلفة .

	Description 
	Web Site

	اكبر شركة للبرمجيات في العالم
	www.microsoft.com

	اكبر شركة كمبيوتر في العالم 
	www.intel.com

	الحكومة الالكترونية المصرية 
	www.egypt.gov.eg

	جريدة الاهرام
	www.al-ahram.org

	جامعة الازهر 
	www.alazhar.org

	موقع مصراوي الشهير 
	www.masrawy.com.

	موقع اسلامي واخباري
	www.ayna.com

	شركة برمجيات وتدريب مصرية 
	www.binaryegypt.com

	البيت الابيض
	www.whitehouse.gov

	موقع للبحث عن كافة البرامج وتنزيلها مجاناً
	www.download.com

	موقع أشهر مضاد للفيروسات
	www.norton.com

	موقع نظام تشغيل 
	www.linux.com

	موقع اتحاد شبكة ويب العالمية الذي وضع معايير تقنيات ويب ولغة HTML
	www.w3.org

	شبكة نسيخ ، اخبار وترفية ومنتديات 
	www.naseej.com.sa

	تعليم لغات 
	www.travlang.com/languages

	تعليم اللغة الفرنسية 
	www.Frenchassistant.com 

	كتب تكنولوجيا المعلومات 
	www.cb4a.com

	منظمة الصحة العالمية 
	www.who.org

	منظمة الاغذية والزراعة 
	www.fao.org 

	الامم المتحدة "الامريكية "
	www.un.org 

	موقع كمبيوتر 
	www.arabia.com

	موقع تسوق ودعاية 
	www.ebay.com


 بعد تصفحك لبعض مواقع الويب يجب علينا الان التعرف علي بعض المهارات . 

التعامل مع Internet Explorer
تعرفنا في السابق علي اهم الايكونات الموجودة بمستكشف الانترنت مثل الامام forward  ,Back   الان نتعرف علي مميزات اخري .

1. حجم الخط Font Size  :- (
لعلك لاحظت اثناء تصفحك لبعض صفحات الانترنت web  pages  لتكبير حجم الخد افتح القائمة View  ثم اختار Text Size  واختار الحجم المناسب .

2. حفظ الصفحة الحالية علي القرص الصلب :  ( 
للرجوع اليها عند قطع الاتصال بالانترنت او لطباعتها بعد تنسيقها أفتح قائمة File  ثم أختار Save As  حفظ بأسم ثم اكتب الاسم الذي تريد الحفظ File Nameبه وحدد  الموقع الذي يتم الحفظ به Save In  . 

لاحظ اثناء حفظ الملف يحفظ تحت إمتداد Extension ( نوع الملف(  *.htm  أو *.html 

Hyper Text markup Language   .

3. اعداد الصفحة للطباعة : (
قبل اتخاذ القرار بطباعة الصفحة لابد من معاينة الصفحة قبل الطباعة عن طريق قائمة File  نختار Print Preview  معاينة قبل الطباعة . 



طباعة الصفحة الحالية : (

لطباعة الصفحة الحالية يتم الضغط علي ايكون الطباعة الموجودة بشريط الادوات او اختيار قائمة ملف File  ثم اختيار الامر Print  . او الضغط مفتاحي Crtl + P  لتظهر لك النافذة الاتية ، ومن ثم يتم تحديد عدد الصفحات المراد طبعتها لانه يتم تقسيم صفحة الويب الي صفحات لتلائم حجم الورق المطبوعة علية وكذلك يتم تحديد عدد النسخ ونوع الطابعة اذا كان موصل بالجهاز اكثر من طابعة . 

4. إيجاد كلمه محددة داخل الصفحة الحالية : ( 
تواجه الجميع مشكله اثناء دخوله علي صفحة ما في الانترنت ويريد البحث عن موضوع معين داخل الصفحة او كلمة او مصطلح داخل صفحة يقرأها  لكنه موجود في موقع ما بالصفحة فيقوم لقرءاة الصفحة ذهاباً وأياباً دون ان يجد ما يريد البحث عنه لكن لحل هذه المشكله .

يتم أختيار قائمة Edit  ثم أختيار Find ( on this page )  او الضغط مفتاحي Ctrl + F  لتظهر لك النافذة الاتية لتكتب ما تريد البحث عنه . 

 

	البحث لاعلي من المكان الذي  اقف عليه بالصفحة الحالية
	Up

	البحث لأسفل 
	Down

	البحث عن ال كلمة بالكامل وليس جزء منها 
	Match whole word only

	نفس هجاء الاحرف  E وليس e 
	Match Case


5. النسخ والتحديد :  ( 
لا يختلف النسخ او التحديد علي ما هو موجود بأي برنامج أخر كـ  MS Word وتحديد الكل select all  وذل

ك بغرض لصق الجزء المنسوخ في اي برنامج نصوص .

	Copy  نسخ 
	Ctrl + C 

	Paste  لصق 
	Ctrl + V 

	Select All تحديد الكل 
	Ctrl + A


6. لتكبير الشاشة Full Screen  : ( 
لنكبير النافذة الخاصة بالمستكشف من قائمة View  ثم أختار Full Screen  أو اضغط من مفاتيح الوظائف Function Keys  المفتاح F11
7. إستخدام إزرار التصفح :  (


للرجوع الي الصفحة السابقة نضغط الزرار Back  ( A  ) وللأمام نضغط الامر Forward  ( B  ) وللرجوع الي الصفحة الرئيسية نضغط Home Page  لإيقاف تحميل الصفحة Stop  ولإعادة تحميلها Refresh  . 

	Back
	Alt  + Left Arrow

	Forward
	Alt  + Right Arrow

	Page Home
	Alt + Home

	Stop
	Esc

	Refresh 
	F5 


8. التحكم في شريط الادوات Toolbar  :  (
لاضافة Icon  او حذفها أفتح قائمة View   ثم اختار Toolbars  ثم  تخصيص Customize  يمكنك بعد ذلك أضافة Add أو حذف Remove  الادوات المختلفة . 


9. تسجيل المواقع المفضله Favorites  : ( 
لتسجيل المواقع التي تفضل الدخول عليها باستمرار افتح قائمة  Favorites ثم أختار Add To Favorites  وأكتب التعليق الذي يذكرك بالموقع مثل Cairo _ Group  لكن أسم الموقع الرئيسي سيظل الجهاز محتفظ به كما هو ويمكنك أنشاء مجلد خاص  بكل فئة من المواقع ( المواقع الدينية ، المواقع التعليمية ، المواقع الترفيهية ) وذلك بأختيار Creat In  ثم كتابة اسم الفئة والضغط OK  ، كم يمكنك تنظيم المفضله بأختيار Organize Favorites  . 




	أنشاء مجلد جديد للمواقع المفضله
	Create Folder 

	اعادة التسمية التوضيحية لموقع
	Rename

	تحريك موقع الي فئة ( مجلد )
	Move to Folder 

	حذف مجلد أو موقع من المفضله 
	Delete


10. لحفظ صورة Save Picture  : ( 
يتم التأشير كليك لمين Right Click  ثم أختار Save Picture as ثم حدد اسم الصورة ومكان الحفظ 


11. فتح نافذة جديدة للبرنامج بنفس محتويات الصفحة الحالية : 

أحياناً يكون تحميل صفحة الويب بطئ للغاية ويمكن ان يبدو البحث معقداً كما انه لا ينتهي الا بعد اضاعة وقت طويل ، عندئذ فكر في فتح نافذة جديدة للتحرك للخلف بسهولة عن طريق Back  أو ترك الصفحى للتحميل Download  ، لفتح نافذة جديدة من قائمة File  ثم أختار New  بعدها أختر Window  أو بالضغط مفتاحي Ctrl + N  . 



12. عرض نتائج البحث في نافذة جديدة :
اثناء نقرك علي احد نتائج البحث في مستعرض الانترنت Internet Explorer  فأنه ينتقل تلقائياً للارتباطLink  الذي نقرت عليه  وبعدها قد تحتاج للرجع الي صفحة البحث الرئيسية ، لتجنب هذه المشكله انقر علي الارتباط كليك لمين Right Click  ثم اختر أفتح في نافذة جديدة Open In New Window .

13. خيارات الانترنت Internet Option  : (
أفتح قائمة Tools  ثم أختار Internet Option  يمكنك من خلال هذه النافذه التي ظهرت لك ان تتحكم في الكثير من المميزات الخاصة Internet Explorer  وقد سبق واشرنا الي أهمية صفحة البداية وكيفية تعيينها Home Page  ، وفي هذا الجزء سنركز علي بعض المميزات الهامه . 

· Temporary Internet Files :

يمكنك مسح ملفات الكوكيز Cookies والملفات المؤقته من جهازك والتي تحمل اثناء تصفحك علي الصفحات المختلفة وتأخذ جزء من المساحة التخزينية علي القرص الصلب ويمكن ان تستغل ملفات الكوكيز في التجسس .

· History :

عن طريق الامر Clear History  يتم مسح اخر المواقع التي قمت بالدخول عليها او تحديد عدد المواقع التي تسمح للجهاز بحفظ عناوينها .

· Colors , Fonts :

التحكم في الوان الروابط قبل النقر او بعد التقر عليها وكذلك نوع الخطوط .

· Advanced :

من هذه القائمة يمكنك الاختيار بين اكثر من امر او الغاء الكثير من الاوامر مثل عدم اظهار الصور في الصفحات المستعرضة وطباعة خلفية الموقع اثناء الطباعة وتشغيل الصوت في صفحات الويب وكذلك الافلام .

Shortcut Keys (Internet Explorer)
	Shortcut Key
	Function

	Home
	الانتقال الي  بداية الصفحة الحالية

	End
	الانتقال الي نهاية الصفحة الحالية

	Alt + Home
	الوصول الي الصفحة الرئيسية Home Page

	Alt + Left Arrow 
	الرجوع الي صفحة للخلف Back

	Alt + Right Arrow
	صفحة للامام Forward

	Page Up 
	شاشة لاعلي

	Page Down
	شاشة لاسفل

	Alt + Esc
	التحويل بين الصفحات المفتوحة

	F11
	تكبير النافذة Full Screen

	Ctrl + F
	البحث عن كلمة داخل الصفحة

	Ctrl + H 
	اخر المواقع التي دخلت عليها مرتبة حسب الايام والاسابيع

	Ctrl + I
	اظهار المفضله والمواقع الموجودة بها

	Ctrl + L 
	فتح نافذة لفتح موقع جديد

	F5 
	اعادة تحميل الصفحة

	Ctrl + P 
	طباعة

	Alt + F4 
	أغلاق المستعرض

	Ctrl + W 
	أغلاق

	Ctrl + A
	تحديد الكل ( نصوص ، صور ، إطارات )

	Esc
	ايقاف تحميل الصفحة

	Ctrl + C 
	نسخ الجزء المحدد من النص

	Ctrl + V
	لصق داخل مربع حواري داخل صفحة الانترنت

	Ctrl + N 
	نافذة جديدة بنفس محتويات الصفحة الموجود بها مؤخراً

	Ctrl + B 
	تنظيم المفضله Organize Favorites

	Ctrl + E 
	بحث

	F1
	مساعدة

	Ctrl + D 
	إضافة الموقع إلي المفضلة


محركات البحث Search Engines
لعلنا أدركنا في الاجزاء  السابقة مدي أهمية شبكة الإنترنت واستخدامها فقد تم التركيز علي المفاهيم الأساسية التي لابد من معرفتها لتسهل لنا التعامل مع الشبكة، لكن قد نسأل أنفسنا هل نستطيع مواكبة التطور الهائل في الشبكة العالمية، وإذا علمنا انه يتم إنشاء سبعة ملايين صفح جديدة يومياً وانه في عام 2000 وصل عدد صفحات الإنترنت إلي أكثر من اثنين بليون صفحة وكان المتوقع أن يبلغ العدد إلي أضعاف هذا الرقم فما توقعك اليوم لعدد الصفحات.

نجد في الحقل الدراسي ومجال العمل نحتاج دائماً الي المعلومات الجديدة وفي الحياة اليومية ، والاعتماد علي الكتب والمجلات العلمية والدوريات شيء ضروري وهام لكن شبكة الإنترنت توفر لك ذلك بشكل أخر وبصورة جديدة بتكلفة أقل بكثير من الطريقة التقليدية  لكن هل تستعين بصديق لك ليعرفك موقع ما قد رأي فيه ما تريد من معلومة لعلها تكون طريقه سهله لكن إذا فعلت ذلك فلم تتعلم الإنترنت بعد فالاعتماد علي الآخرين في البحث تكون رؤية تحيزية لمواقف وأفكار الشخص الآخر ولم تستفد شيء بعد لأنه ما زال ملايين المواقع علي الشبكة في انتظارك بها كل جديد وحديث في كافة المجالات المختلفة فمن خلال وسائل الإعلام المختلفة تجد أن شبكة الإنترنت بها كل ما تريد أن تسأل عنه دون حدود أو قيود ، والمعرفة العلمية بأساسيات البحث توفر لك الكثير في الوقت والجهد وتجعلك قادر علي أن تصل إلي المواقع الجيدة  أو الموضوع الذي تريده في اقل وقت ممكن مع استيفاء صحة ودقة المعلومة .

ورأيت كثيراً أثناء المناقشات البناء ه مع المستخدمين من ذوي الخبرة للإنترنت إن اعتمادهم في البحث علي الخبرة الشخصية والمعلومات التي يتبادلونها عن طرق جديدة في البحث دون معرفة علمية جادة، وقد رأيت لهم عذراً أن المكتبة العربية فقيرة في محتواها في الكتب التي تتحدث عن محركات البحث والتي تزيد عن ستين محرك وان تم التحدث يكون في بعض وريقات من كتاب للشبكة العالمية فتعمدت أن أتحدث في هذا الفصل عن محركات البحث وان أركز علي احدي المحركات الشهيرة مدعوما ذلك ببيانات وتفاصيل فنية قامت الشركة المسئولة عن محرك البحث بإعدادها وكذلك من مصادر عديدة أخري.

هذا الفصل سيتم دراسة أساسيات البحث ومحركات البحث وكيفية عملها, وأدوات البحث الأساسية وكذلك دراسة محركات البحث ومهارات البحث عن ملفات بعينها وكيفية تحميل الوسائط المتعددة.


إذا سألت شخص قام بالفعل بتجربة استخدام أحد محركاتSearch Engine البحث للإجابة علي سؤال معين أو تعقب حقيقة معينة فمن المرجح انه لم يعثر علي شيء في الإنترنت ويتضح له أن المعلومات الكثيرة التي ظهرت له في النتائج Results ليست ذات قيمة وبالتالي فأنه يتوقف عن البحث وللمشكلة وجهان.

أولاً: أن الإنترنت ضخم للغاية كما ذكرنا وينقصها التنظيم وبالتالي فأن العمليات الطويلة للبحث ينتج عنها إحباط كبير للمستخدم.

ثانياً : لا يعي معظم الأشخاص الذين يستخدمون محرك البحث ما طبيعة هذه المحركات ولا يكلفون أنفسهم عناء التعرف علي كيفية الاستفادة الكاملة من ميزاتها الفريدة والتي تختلف من محرك إلي أخر فأنهم يكتبون ببساطة كلمه او كلمتان فقط في نموذج Form البحث ثم يفاجئون عندما يحصلون علي ملايين صفحات الويب البعيدة عن موضوع البحث . 

ومن غير المرجح أن الإنترنت ستصبح اقل فوضوية في الفترة الكبيرة نظراً للعدد الكبير من الصفحات والتي تضاف إليه يومياً Daily ولا يوجد شخص مسئول عن الإنترنت لذلك الاهتمام بمحركات البحث هي نظرة لمستقبلك فيما بعد لتعاملاتك مع الإنترنت. 

( تعريف محركات البحث:

يعد محرك البحث أداه تسمح لك باستكشاف قواعد البياناتData Base  التي تحتوي علي نصوص من المئات من الملايين من صفحات الويب Web Pages  وعندما يعثر محرك البحث علي الصفحات التي تتطابق فإنه يقدمها لك بشكل مختصر وارتباطات يمكنك النقر فوق الارتباطLink  الموجود بها لنقلك مباشرة إلي الموقع .

تركز بعض محركات البحث Google علي عمل قاعدة بيانات تقوم بتوفير إمكانيات بحث قوية بشكل أساسي وتقديم أكبر قاعدة بيانات ممكنة من صفحات الويب، بينما يقوم البعض الآخر بالمنافسة بشكل مختلف مثل Yahoo ( من أكثر المواقع شهرة علي الإنترنت ) بعمل دليل Directory موضوعات متعدد المستويات لتصفح مجموعة صغيرة للغاية من صفحات الويب بحثاً عن المعلومات المتعلقة بموضوعات محدده يقوم بإعداد هذه الأدلة أشخاص ( فريق عمل من متصفحي Yahoo ) يقضون أيامهم في زيارة مواقع الويب Web Sites وتصنيفها اعتماداً علي المحتوي ومن المحركات الاخري التي تقوم بنفس الفكرة LookSmart وبدأ محرك Google والأكثر شهرة في العالم بمحاولة تطبيق نفس الفكرة إلا أنها لم تصل إلي ما وصلت إليه في الدلائل حتى الآن.


( كيفية عمل محركات البحث: 

يتم تصميم محركات البحث لكي تسهل لك إلي أقصي حد ممكن العثور علي ما تريده علي الإنترنت، ولكن بوجود ملايين الصفحات المخزنة علي جميع أجهزة العالم التي يتم إضافة المزيد منها كل يوم كيف يمكن لمحركات البحث جمع كل هذا وكيف تتعامل محركات البحث بمجرد ان تحصل عليها ؟



يتمثل أكبر تحدي عند إجراء أي نوع من البحث علي الإنترنت في اختيار مصطلحات البحث الصحيحة أو الكلمات الأساسية الصحيحة للبحث لان عند بحثك في احد محركات البحث فإنك تبحث عن النص الكامل لصفحات الويب Web Pages التي تم تجميعها Collect بشكل تلقائي بواسطة برامج Spider or Crawlers، إذا تم سؤال أمين مكتبة أو باحث محترف يستخدم قواعد البيانات القوية مرتفعة التكلفة مثل Dow Jones & News Retrieval & Dialog عن البحث بالنص الكامل وسيخبرونك بأنه يعتبر في الحقيقة أصعب نوع من أنواع البحث في عالم الانترنت.

( كيفية اختيار الكلمات الأساسية الصحيحة: 

لكي تتعلم كيفية استنتاج أكثر الكلمات الأساسية فعالية لعمليات البحث علي الويب وقتاً تدريبياً ، ولا يجب عليك أن تيئس  أو تندهش وقد تشعر بالإحباط وقد مررنا بنفس التجربة ، حيث إن أفضل الباحثين عبر الانترنت يجدون أن البحث علي الويب يعد تحدياً ، لا ادعي ان لدي كل الإجابات علي أسئلتك الخاصة بالمصطلحات ولكن فيما يلي بعض النقاط التي يمكنك الاستعانة بها  لمساعدتك علي تحسين معدل نجاح البحث علي الويب الانترنت .
( للحصول علي أفضل النتائج:

1. استخدم أكثر الكلمات الأساسية التي يمكن التفكير فيها تميزاً وتفرداً:
أستغرق الوقت الكافي للتفكير في الكلمات التي ستظهر بشكل مؤكد في نوع صفحة وابتعد دائماً عن الكلمات الشائعة إذا كنت تبحث عن أهمية الكيمياء أو الفيزياء في الصناعة فلا تبحث عن كيمياء أو فيزياء لكن ابحث عن تخصص موجود في الكيمياء أو الفيزياء مثل الكيمياء النووية او الحيوية أو أشعة الليزر بعض المواقع تحتاج الي وضع الكلمات بين علامتي تنصيص"Biochemistry" وغالباً ما تحصل علي نتائج محددة وجادة في نفس المجال الذي حددته.

2. حاول ثم حاول ثم أجتهد :
لا تفترض انك ستعثر علي النتائج من اول مرة قم بالبحث ثم المراجعة لأول صفحتين علي الاقل ولا تتجاهل النتائج الهامة اما الكلمات التي تم تحديدها الفريدة ضع بعض الملاحظات وضعها في الاعتبار ثم قم بأجراء عملية بحث أخري فربما النتائج عن "هم المساجد الموجودة بمصر"يعطي نتائج مختلفة عن البحث عن"المساجد الهامة بمصر "

3. تضييق مجال البحث :
إذا كانت نتائج الكلمة الأساسية التي اخترتها  تعد نتائج جيدة نسبياً قم بأجراء بحث ثاني علي هذه النتائج فقط تتم الإشارة إلي ذلك انه بحث محدد وتسهل معظم محركات البحث الرائدة هذا النوع من البحث فسوف تجد في محرك البحث ما يشير الي امكانية البحث في النتائج  المتحصل عليها حالياً Search withen these results ( بحث في هذه النتائج ) ولكن إذا لم يوفر لك محرك البحث نفس الشيء بشكل أساسي عن طريق إضافة كلمة أساسية أخري لطلب البحث الخاص بك وتقديمه مرة أخري .

4. أكتشف إذا ما كانت حالة الأحرف لها أهمية أم لا :
يجب أن تعرف ما إذا كان محرك البحث الذي تستخدمه ينتبه للأحرف الكبيرة والصغيرة Uppercase or Lowercase في الكلمات الأساسية التي تقوم بإدخالها أم لا ، هل ستعثر عملية البحث عن Java  وهو برنامج تنتجه شركة Sun Microsystems  علي المواقع التي تشير أيضا إلي البرنامج Java ، حيث تتجاهل بعض محركات البحث حالة الأحرف Case Sensitive  مثل Google  لكن يوجد محركات بحث أخري مثل AltaVista  و HotBot إذا استخدمت أية أحرف كبيرة سيفترض محرك البحث أنك ترغب في البحث عن هذا المزيج من الأحرف وبالتالي لإجراء أكثر عمليات البحث أتساعاً علي قدر الامكان ، وعادتاً ما يكون في بعض الأحيان استخدم حالة الأحرف الصغيرة في الاستعلامات .

5. أستخدم محركات البحث المتعددة :
لكل محرك بحث طريقة خاصة لأداء الأشياء ولا يغطي منهم كل شيء حتى Google  الذي يمتلك حق الافتخار بكونه أكبر قاعدة بيانات لصفحات الويب لم يعثر بعد علي أكثر من 60 % من مواقع الويب ويقوم بفهرستها عندما يكون للشمول أهمية يجب عليك استخدام محركات بحث متعددة ، حيث يمكنك تقديم استعلام تلقائياً لمحركات بحث متعددة باستخدام ما يطلق علية البحث الشامل ومن أكثر هذه الخدمات وأكثرها شيوعاً والتي لها عدد كبير من المستخدمين www.Metacrawler.comوكذلكwww.dogpile.comو ww.infind.com وقد نالت هذه الفكرة استحسان العديد من الباحثين المحترفين أو المبتدئين إثناء طرحها في المحاضرات الذين وجدوا أنها تمثل توفيراً حقيقياً للوقت وسيتم مناقشة احد محركات البحث بالتفصيل في الموضوعات اللاحقة بهذا الفصل.


الآن أصبح لديك وعي أساسي لمعني محرك البحث لكن يجب علينا أن نؤكد وندعم هذا الوعي وذلك بمعلومات عن أهم محركات البحث الكبرى في العالم بالإضافة إلي دراسة أهم خصائصها الفريدة الخاصة بكل محرك واليك أسماء وعناوين أهم محركات البحث السبعة الكبرى في شبكة الانترنت .بالإضافة إلي ذلك سنذكر أيضا محركات البحث ذات الأغراض الخاصة .
	Web Site
	Name

	www.altavista.com
	AltaVista

	www.google.com
	Google

	www.hotbot.com
	Hotbot

	www.Lycos.com
	Lycos

	www.northernlight.com
	Northernlight

	www.yahoo.com
	Yahoo

	www.msn.com
	MSN

	محركات البحث ذات الأغراض الخاصة 

	البحث عن المجموعات الإخبارية 
	Deja

	العثور علي أدله الموضوعات 
	Argus Clearinghouse

	العثور علي البريد الالكتروني وأرقام وهواتف الأشخاص 
	InfoSpace 

	لمعلومات الحاسب 
	ZDNet

	للمصادر القانونية 
	FindLaw

	الخرائط العالمية واتجاهات القيادة 
	MapQuest



أقوي محركات البحث العالمية 

· معنى  Google: 
كلمة "Googol" هي مصطلح رياضي يعني 1 متبوعًا بمائة (100) صفر. وقد وضع هذا المصطلح العالم ميلتون سيروتا؛ ابن أخت عالم الرياضيات الأمريكي إدوارد كاسنر، وانتشر هذا المصطلح في كتاب "Mathematics and the Imagination" (الرياضيات والخيال) الذي ألَّفه كاسنر وجيمس نيومان. واختيار Google لهذا المصطلح يعكس المهمة التي تقوم بها الشركة؛ وهي تنظيم ذلك الكم الهائل من المعلومات المتاحة على الويب.

( لمحة تاريخية عن محرك البحث Google  : 


تتمثل مهمة Google في تنظيم المعلومات الدولية وتسهيل الوصول إليها والإفادة منها عالميًا، وكخطوة أولى لإنجاز هذه المهمة؛ قاما مؤسِسا Google لاري بيدج وسيرجي برين بتطوير أسلوب جديد للبحث على الإنترنت، وكان مَنشأ هذا الأسلوب هو إحدى قاعات جامعة ستانفورد، ثم انتشر بسرعة بين الباحثين عن المعلومات حول العالم. وGoogle الآن معروفة على نطاق واسع بأنها صاحبة أكبر محرك بحث على مستوى العالم والذي يوفر خدمة مجانية سهلة الاستخدام ويعطيك عادة النتائج ذات العلاقة في جزء من الثانية. 
وبزيارتك لموقع www.google.com/ أو واحدًا من نطاقات Google العديدة الأخرى؛ تستطيع العثور على المعلومات بلغات مختلفة، والإطلاع على أسعار الأسهم، والخرائط، وعناوين الأخبار، والبحث في قوائم أدلة الهاتف لكل مدينة في الولايات المتحدة الأمريكية، والبحث عن ملايين من الصور ومطالعة أكبر أرشيف رسائل في العالم: أرشيف Usenet الذي يحتوي على أكثر من بليون من النشرات التي يرجع تاريخها إلى سنة 1981. 

أساسيات البحث في Google 


أساسيات بحث Google :
إن إجراء بحث من Google أمر سهل. ببساطة اكتب واحدًا أو أكثر من مصطلحات البحث - الكلمات أو العبارة التي تصف بدقة المعلومات التي تريد العثور عليها – في صندوق البحث وانقر فوق مفتاح "Enter" (إدخال) في لوحة المفاتيح أو انقر فوق زر Google Search (بحث Google).
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ويستجيب بحث Google بعرض صفحة نتائج: وهي قائمة بصفحات الويب ذات العلاقة بمصطلحات بحثك؛ حيث تظهر أكثر الصفحات علاقة في المقدمة ثم التي تليها وهكذا. 

وفيما يلي بعض النصائح الأساسية لمساعدتك على الحصول على أفضل فعالية لبحثك والخاصة بمحرك البحث Google كما اشرنا سابقاً الي ان لكل محرك بحث خصائص خاصة به : 

1. اختيار مصطلحات البحث 

2. الكتابة بحروف كبيرة 

3. أسئلة "و الآلية استبعاد الكلمات الشائعة 

4. بحوث العبارات 

5. المصطلحات السلبية "ضربة حظ" 


1. [image: image120]اختيار مصطلحات البحث :

إن اختيار مصطلح البحث الصحيح هو مفتاح العثور على المعلومات المطلوبة. ابدأ بالمصطلح الواضح – فإذا كنت تبحث عن معلومات عامة عن مدينة القاهرة مثلاً؛ فجرِّب البحث بكلمة الكيمياء ولكن من الأفضل غالبًا أن تستخدم مصطلحات بحث متعددة؛ فإذا كنت تريد معلومات محددة عن احد فروع الكيمياء ؛ سيكون من الأفضل استخدام الكيمياء الحيوية  بدلاً من كيمياء بمفردها أو الحيوية  بمفردها. وقد يُعطي استخدام إنجازات الكيمياء الحيوية  نتائج أفضل بكثير - أو أسوأ حسب وجهة نظرك. 
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كما يُفضل أن تسأل نفسك عما إذا كانت مصطلحات بحثك محددة بدرجة كافية أم لا. فالبحث عن موضوع ما في الكيمياء الحيوية مثل الكربوهيدرات أفضل من البحث عنها بالكلمات موضوعات الكيمياء. ولكن يجب عليك اختيار مصطلحات بحثك بعناية؛ لأن Google تبحث عن مصطلحات البحث التي تختارها أنت. ولذلك فمن المحتمل أن يعطيك البحث بكلمات محددة نتائج أفضل من البحث عن عبارة طويلة.

2. الكتابة بحروف كبيرة ( للغة الإنجليزية ) :
إن بحوث Google ليست حساسة لحالة الحروف. فكل الحروف الإنجليزية – بصرف النظر عن طريقة كتابتها – يتم التعامل معها على أنها مكتوبة بالحروف الصغيرة. فعلى سبيل المثال؛ البحوث باستخدام george washington، وGeorge Washington، وgEoRgE wAsHiNgToN ستعطي نفس النتائج.

[image: image123]
3. استبعاد الكلمات الشائعة آليًا :
تتجاهل Google الكلمات والرموز الشائعة باللغة الإنجليزية مثل "where" (أين) و"how" (كيف)؛ بالإضافة إلى أرقام وحروف مفردة معينة؛ لأنها تؤدي إلى تقليل سرعة البحث دون تحسين النتائج. وفي حالة استبعاد كلمة شائعة؛ تشير Google إلى ذلك عن طريق عرض تفاصيل في صفحة النتائج أسفل صندوق البحث.

وإذا كانت الكلمة الشائعة ضرورية للحصول على النتائج المطلوبة؛ فيمكنك تضمين هذه الكلمة بوضع علامة "+" أمامها. وتأكد من وضع مسافة قبل علامة "+".

وطريقة أخرى لفعل ذلك بأن تُجري بحث عبارة؛ والذي يعني ببساطة وضع علامتي اقتباس حول كلمتين أو أكثر. ويتم تضمين الكلمات الشائعة – مثل "أين أنت" – في بحوث العبارات. 

فعلى سبيل المثال؛ للبحث عن مصر ومدينة القاهرة ؛ استخدم:
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أو ------------------
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4. بحوث العبارات :
في بعض الأحيان تريد العثور على نتائج تحتوي على عبارة معينة. وفي هذه الحالة؛ ببساطة ضع علامتي اقتباس حول مصطلحات بحثك. 
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تتميز بحوث العبارات بفعاليتها وخاصة عند البحث عن أسماء شخصيات – مثل "جمال عبد الناصر" - أو قصائد شعرية – مثل "معلقة عنترة" - أو غيرها من العبارات المشهورة مثل "الإرادة سر النجاح".

5. [image: image131]المصطلحات السلبية :
إذا كان مصطلح بحثك يحتمل أكثر من معنى – مثل كلمة شعر (قصائد شعرية) أو (شعر الرأس)؛ – فيمكنك تركيز بحثك عن طريق وضع علامة الطرح "-" أمام الكلمات المرتبطة بالمعنى الذي تريد تجنب، فعلى سبيل المثال؛ يمكنك العثور على صفحات حول الشِعر والقصائد الشعرية وليس شَعر الرأس بالطريقة التالية: 
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ملاحظة: عند تضمين مصطلح سلبي في بحثك؛ تأكد من وضع مسافة قبل علامة الطرح "-". 

6. "ضربة حظ" :
بعد إدخال مصطلحات بحثك؛ قد تريد تجريب استخدام زر "ضربة حظ" والذي يأخذك مباشرة إلى مواقع الويب التي وجدتها Google الأكثر علاقة باستفسارك. وفي هذه الحالة لن ترى صفحة نتائج البحث مطلقًا؛ ولكن إذا فعلت ذلك؛ سيتم تدوين موقع "ضربة حظ" في أعلى الصفحة. فعلى سبيل المثال؛ إذا كنت تبحث عن الصفحة الرئيسية لجامعة بيروت؛ فما عليك إلاَّ أن تقوم بإدخال عبارة جامعة بيروت والنقر فوق زر "ضربة حظ" بدلاً من زر "بحث Google". وستأخذك Google مباشرة إلى الموقع "www.Alahram.org.eg" 
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البحث المتقدم Advanced Search 

ربما ترغب - بعد معرفتك أساسيات بحث Google – في أن تُجرِّب البحث المتقدم Advanced Searchالذي يُقدم لك خيارات عديدة لجعل بحوثك أكثر دقة؛ وللحصول على المزيد من النتائج المفيدة. ويمكنك الوصول إلى صفحة البحث المتقدم بالنقر فوق وصلة "بحث متقدم" في الصفحة الرئيسية لـ Google. وبواسطة بحث Google؛يمكنك القيام بما هو أكثر بكثير من مجرد كتابة مصطلحات البحث. فبواسطة "البحث المتقدم"؛ يمكنك البحث عن صفحات: 

· تحتوي على "كل" مصطلحات البحث التي تكتبها 

· تحتوي على العبارة الدقيقة التي تكتبها 

· تحتوي على واحدة على الأقل من الكلمات التي تكتبها 

· لا تحتوي على أي من الكلمات التي تكتبها 

· مكتوبة بلغة معينة 

· منشأة بصيغة ملف معين 

· تم تحديثها في فترة زمنية معينة 

· في نطاق معين أو موقع ويب معين 

1. معامِلات" البحث المتقدم  :
يمكنك أيضًا تحسين بحوثك بإضافة "مُعامِلات" إلى مصطلحات بحثك في صندوق بحث Google؛أو باختيار هذه المُعامِلات من صفحة البحث المتقدم. تتضمن مُعامِلات البحث المتقدم: 
	
طريقة عمله وأمثلة على ذلك
 
	
مُعامل البحث
 

	يُستخدَم هذا المُعامل للبحث عن عبارة محددة.
“computer technology”
(تُعرَض عندها مواقع الويب التي تحوي هذه العبارة مع مراعاة ترتيب كلماتها) 

	
" " 


	تُستخدَم مع مجموعة من الكلمات للبحث عن مواقع تحوي هذه الكلمات (منفردة أو مجتمعة).
Computer + technology 
(تُعرَض عندها المواقع والصفحات التي تحتوي كلمة computer وكلمة technology ولكن ليس بالضرورة أن توجد الكلمتان مع بعضهما في الموقع نفسه). 
	
AND أو +


	يُستخدَم مع مجموعة من الكلمات للبحث عن كل من هذه الكلمات المفتاحية على حدة.
Computer OR technology 
(تُعرَض المواقع التي تحوي كلمة computer بمفردها، والمواقع التي تحتوي كلمة technology بمفردها) 
يجب مراعاة ترك مسافة قبل OR وعدم ترك مسافة بعدها. 
	OR

	يُستخدَم رمز النجمة للبحث عن كلمة عُلِمَ أحد مقاطعها، ويسمى البحث باستخدام الحروف البديلة (wildcard search).
مثال:                 Tech*
تعرض المواقع التي تبدأ كلماتها بالمقطع   Tech  مثل:(technology, technician, technical, ..)  
	


· بحث التضمين 
· بحث التخيير OR

· بحث النطاق 

· مزايا بحث متقدم أخرى 


 ( معاملات البحث:
ذكرنا سابقاً أن محركات البحث تستخدم في بحثها عن مواقع الويب ما يدعى الكلمات المفتاحية (keywords) التي يمكن أن تكون كلمة أو عبارة (phrase). وتَستخدِم معاملات أو آليات البحث عادةً بعضَ المعاملات (operators)، مع هذه الكلمات المفتاحية، لتوفير خيارات إضافية لعملية البحث. ونعرض في الجدول التالي كيفية عمل بعض هذه المعاملات، إلى جانب بعض الأمثلة عليها:

2. التعريفات Defines  : 
للعثور على تعريف لكلمة أو عبارة؛ ببساطة اكتب كلمة"define" باللغة الإنجليزية)، ثم ضع مسافة، ثم اكتب الكلمة أو العبارة التي تبحث عن تعريفها (باللغة الأنجليزية). وفي حالة عثور Google على تعريف لهذه الكلمة أو العبارة على الويب؛ فإنها تجلبه وتعرضه في مقدمة نتائج بحثك. 
مثال:  

Top of Form
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Bottom of Form
3. البحث في موقع :

كلمة "موقع" (باللغة الإنجليزية) متبوعة بنقطتين تُمكِّنك من قصر بحثك على موقع معين. ولفعل ذلك؛ استخدم التركيب site:sampledomain.com في صندوق بحث Google. على سبيل المثال؛ للعثور على معلومات عن القبول في جامعة ستانفورد على موقع الجامعة؛ اكتب:
مثال:  
Top of Form
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Bottom of Form

1. البريد الإليكتروني والدردشة والمؤتمرات عن بعد ومجموعات المناقشة

Electronic Mail , Chatting , Video Conferencing and Groups 


· طرق التواصل الحديثة :
يعد البريد الالكتروني من الأدوات الهامة بالانترنت للأشخاص والمؤسسات ورجال الأعمال والاقتصاد والباحثين باختلاف التوجهات المختلفة ، حيث يمكنك إرسال آلاف الرسائل مجانا عبر البريد الاليكتروني في اقل فترة زمنية وفي خطوات  بسيطة ، تقوم بعض الشركات بإتاحة خدمة البريد الاليكتروني مثل Yahoo ‘ Hotmail ‘ Gmail  ولعل من أهم مميزات البريد الاليكتروني تبادل المعلومات بين الأشخاص والأفراد ويلعب محوراً رئيسياً في الدعاية .

وهل يمكن ان أقول أن كل الناس يمكنهم الاتصال ببعضهم البعض ( على اختلاف أنواع أجهزة الحاسب الذي يعملون عليها ) عن طريق البريد الالكتروني، يقول الأمريكيون ان رنين التليفـون مزعج وأنه يقطع على الناس خاصة أصحاب الفكر حبل أفكارهم، وأنه لاحاجه بنا للبحث عن مكان ليتوافر فيه تليفون أو الانتظار فى كابينات التليفون المنظمة بالساعات لمحاوله التحدث مع قريب يبعد عنا آلاف الكيلومترات( هل كل ذلك حقيقي ).

فأن البريد الالكتروني يلعب دورا حيويا في مجال الترتيب لعقد الاجتماعات Video   Conference   وعلى سبيل المثال فأنك عبر رساله واحده تكتبها مرة واحدة يمكنك توزيعها عشرات أو مئات أو حتى آلاف المرات - اذا استدعى الامر ذلك كما يمكنك عمل مؤتمرات على البعد عن طريق البريد الالكتروني.

(  عملي : E_mail ! Chat ! Video Conference ! Groups 

2. التعليم عن بعد Distance Learning  :

في ظل التغيرات التكنولوجية السريعة والتحولات في أوضاع السوق , فإن النظام التعليمي في العالم يواجه تحدياً بخصوص الحاجة إلى توفير فرص تعليمية إضافية وذلك دون الحاجة لزيادة ميزانيات إضافية . لذلك فإن العديد من المؤسسات التعليمية قد بدأت تواجه هذا التحدي من خلال تطوير برامج التعليم عن بعد .

ويتم التعليم عن بعد بشكل مبدئي عندما تفصل المسافة الطبيعية ما بين المعلم والطلاب ، خلال حدوث العملية التعليمية , حيث تستعمل التكنولوجيا مثل الصوت , الصوت والصورة , المعلومات , والمواد المطبوعة . إضافة لعملية الاتصال التي قد تتم وجهاً لوجه , لسد الفجوة في مجال توجيه التعليمات .

هذه الفرص والبرامج تتيح للبالغين فرصة أخرى للتعليم الجامعي , أو تصل إلى الأشخاص الأقل حظاً سواء من حيث ضيق الوقت أو المسافة أو الإعاقة الجسدية , هذا عدا عن أن هذه البرامج تساهم في رفع مستوى الأساس المعرفي للعاملين وهم في موقع عملهم وقد أدي ذلك أيضاً إلي فتح مجال جديد للتنافس بين الجامعات، وبما يخدم العملية التعليمية عن طريق نظام غير تقليدي، هو نظام التعليم عن بُعْد، الذي تُستخدم فيه الوسائل المرئية، وشاشات الكمبيوتر، والأقمار الصناعية، وشبكات الاتصالات الإلكترونية؛ لتحقيق الربط بين الجامعات عبر الدول، وبينها وبين الدارسين والمشاركين في هذا النمط غير التقليدي من التعليم؛ ونقل المعرفة بما يحقق الفائدة العلمية البحثية، من خلال دراسة المقررات، وتبادل المعلومات، وعقد الندوات والمؤتمرات، وتوفير قنوات التعليم؛ دون حاجة لانتقال الدارسين إلى داخل المؤسسة التعليمية.
· عملي : زيارة الجامعات والمؤسسات الدولية المتخصصة في التعليم عن بعد 
 ( يتمتع هذا النوع من التعليم بمميزات كثيرة منها:
1. التغلب على العائق الزمني الذي يحرم الكثير من الدارسين الذين لا تتلاءم ظروفهم العلمية والعملية والحياتية مع الجداول الدراسية للتعليم النظامي.

2. التغلب على العائق الجغرافي الذي يحرم الكثير من الدارسين من الالتحاق بالتعليم العالي النظامي؛ إما لبُعْد المسافة، أو لضيق السعة المكانية المتاحة للمؤسسة الأكاديمية.

3. الاستفادة القصوى من الطاقات التعليمية المؤهلة؛ بدلاً من تكديسها في الجامعات النظامية، وانشغالها بإلقاء المحاضرات على عدد محدود من طالبي العلم؛ بل يستفيد منها عدد غير محدود من الدارسين؛ عبر التقنية الحديثة للاتصالات ونقل المعلومات.

4. أنه نظام يلغي قيود الزمان والمكان، ولا يستوجب الالتقاء المباشر بين الدارسين والمدرسين؛ فهو نظام يجسد حرية نقل المعلومات وحرية الاختيار.

5. القدرة على تحقيق ونشر التعليم لكل أفراد الأمة الإسلامية.

6. أنه نظام يمكن الطالب والطالبة من الجمع بين الوظيفة والتعليم، ويمكن المتعلم من الالتحاق بالجامعة في الوقت والمكان المناسبين.

7. قدرة هذا النظام على التواؤم مع طبيعة المجتمع وظروفه الاقتصادية، والثقافية، والاجتماعية.

8. التمكن من إعداد حقائب تعليمية وتدريبية جاهزة ومتكاملة؛ قبل وصولها إلى الطالب؛ لضمان قدرتهم على متابعة تعليمهم.

9. اعتماد المرونة في الأنظمة ولوائحها المتعلقة بقبول واستمرار أكبر عدد من الطلب.

10. قدرة الجامعة على تطبيق برامجها الدراسية؛ في مدد زمنية مختلفة؛ تتوافق مع طول تلك البرامج، ورغبة الطالب الملتحق بها.

3. التسوقShopping  :  

يوجد أسباب كثيرة تدعو إلى الاستفادة من الإنترنت في إجراء عملية التسوق لكل أنواع البضائع من سيارات وبرامج ومجوهرات وملابس وكتب وزهور.. الخ. حيث بدأت العديد من المتاجر المشهورة على مستوى العالم بافتتاح متاجر افتراضية لها على شبكة الإنترنت بعد أن وجدت أن التجارة عبر الشبكة تحقق أرباحاً مدهشة مقارنة بما تتطلبه من نفقات سنتطرق لاحقاً لكيفية إنشاء موقع للتجارة الافتراضية عموماً حديثنا اليوم هو عن التسوق عبر الشبكة. 
( كيف يتم وما هي الخطوات التي يجب مراعاتها قبل الشراء؟

· بقليل من البحث نقترح قراءة بعض الخبرات السابقة من خلال زيارة لبعض مواقع المجموعات الإخبارية التي توفر الكثير من المعلومات عن عمليات التسوق ذكر منها www.dejanews.com حيث النقاشات حول الخبرات الشخصية عن التسوق جيدها وسيئها. 
· معرفة أفضل العروض: تتوفر على الشبكة الكثير من المواقع التي توفر خدمة للمتسوقين عن افضل العروض المتوفرة عبر الشبكة، وفي هذا فائدة كبيرة حيث إن المتسوق الجديد قد يجد صعوبة في اتخاذ قرار الشراء ما لم يكن على علم بأفضل العروض وعناوين المواقع التي توفر تلك العروض. 
مثال على ذلك www.pricewatch.com.
· خدمة حية للزبائن: live Customer Support توفر بعض المواقع خدمة حية للزبائن من خلال الرد على الاستفسارات حول البضاعة التي تنوي شراءها. 
يوفر الموقع التالي فكرة عن المواقع وخدماتها وطرق توصيل البضاعة الشحن
www.bizrate.com.
· مواقع أخرى توفر خدمات للزبائن حيث توفر قوائم لشكاوى الزبائن حول مواقع التسوق عبر الشبكة وذلك للتجنب المواقع التي يوجد الكثير من الشكاوى ضدها مثل
www.multicheck.com. 
هذه الخدمة مجانية ومفيدة جداً.
· موقع أفضل المواقع للتسوق www.bbbonline.org وهو مكتب Better  Business Bureau يوفر العديد من الأفكار والنصائح حول التسوق عبر الشبكة، 
كما يوفر خدمة المساعدة للحصول على أفضل المواقع التي يوفر ما تنوي شراءه، 
إضافة إلى ذلك يوفر الموقع العديد من عناوين المواقع عن الشركات التي توفر خدمة التسوق 
كذلك يمكّنك الموقع من تقديم أي شكاوى في حالة عدم رضاك عن منتج قمت بشرائه. 

· عمل اختبار للموقع من خلال إرسال رسالة إلكترونية email تستفسر من خلالها عن البضاعة التي تنوي شراءها، من خلال الموقع ويمكنك الحكم من خلال الرد أي الوقت الذي استغرق لكي يرد على رسالتك وكمية المعلومات المرسلة لك حيث إن ذلك أفضل طريقة للحكم على الموقع. 
· النواحي الأمنية التي تشكل هاجساً كبيراً لدى العديد من مستخدمي الشبكة لكثرة القصص التي يكتب عنها حول السرقات والاختراقات التي تتم عبر الشبكة. ما أود تأكيده هو أن الكثير من الشركات الكبيرة والمشهورة تقدم هذه الخدمة ولم يسبق أن قدم فيها أي شكوى من قبل المتسوقين. 
· كذلك يوفر المتصفح مثل مستكشف الإنترنت من قبل مايكروسوفت أو البحار من قبل نتسكيب تجد أن الموقع الآمن يوفر قفلاً أو مفتاحاً في اسفل الشاشة ليعطيك معلومة أن الموقع الذي أنت به آمن. 
· كما أن الموقع الآمن يصبح عنوان الموقع به حرف S مثل https بدلا من http فقط وهذا هو دليل آخر على أن الموقع آمن. 
· ويوجد بعض المواقع الآمنة لعملية التسوق مثل موقع ياهو www.yahoo.com وموقع أمازون www.amazon.com وموقع شانيل www.chanel.com موقع لبيع العطور والمجوهرات. 
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باينري سيستمز  مصر للتدريب وتكنولوجيا المعلومات والإستشارات التكنولوجية 

تعمل بالتعاون مع كبري الشركات العالمية 
( " رؤيتنا " التدريب المزدوج الذي يعتمد علي الربط  بين الواقع العملي  لما  تطلبه الشركات والمؤسسات والبنوك في العالم العربي وبين القدرات الفردية والعمل علي تنميتها من واقع عملي وعلمي مدروس بعنايه فائقة .
( " رسالتنا " التواصل بين المتدرب وما تطلبة الشركات من خلال علاقة الشركة بكلاً منهما في مجالي التدريب والإستشارات والخدمات التكنولوجيه . 
(" هدفنا " تحقيق طموحاتك العلمية وإمداد المورد البشري الكفء لكافة ارجاء الوطن العربي .

( بإلتحاقك بدورات  باينري  : 

· المادة العلمية الكاملة لكل دورة +  عضوية مجانية في المكتبة الإلكترونية 

· شهادة باينري مصر المعتمدة من كبري الشركات العالمية 

· الدعم الفني بكافة الوسائل حتي  بعد إنتهاء الدراسة 

· مساحات مجانية علي Server  الخاص  بالشركة وخدمات أخري * 

· تدريبك بمشاريع واقعية  للشركات + إتاحة الفرصة للتدريب والإحتكاك بواقع العمل 

· مهارات التقدم للوظائف وترشيح سيرتك للشركات المتعاقدة معنا في الخدمات التكنولوجية . 





Training Diplomas / Courses 

	Basic & Management & Accounting Diploma 

	Fees(L.E) 
	Hr.
	Code
	Name

	160
	24
	GD04
	Basic Diploma ( 4 courses ) 1 Free 

	240
	60
	GD09
	MS office 2003&2007 Diploma ( 6 Courses) 

	280
	84
	GD512
	Advanced G Diploma ( 8 Courses )1 Free 

	240
	48
	A01
	Accounting Diploma ( 6 Courses ) 

	120
	16
	E02
	E- commerce 

	160
	24
	E05
	E-Marketing 

	-
	24
	E03
	E- Business

	180
	24
	M04
	Secretary  Diploma 

	Graphic & Web Design & Multimedia 

	650
	84
	G03
	Graphic Diploma (C9,C26,C19,C15,…) 

	-
	84
	D04
	Multimedia Diploma 

	-
	60
	W02
	Web Design Diploma 

	-
	36
	C9
	Adobe  Photoshop 

	-
	24
	C23
	Adobe Illustrator 

	-
	16
	C24
	Free Hand 

	-
	24
	C26
	Macromedia Flash & Swich max 

	-
	16
	C25
	Corel Draw 

	]- 
	24
	C19
	Dream Waver 

	120
	8
	C15
	SEO

	-
	48
	C20
	3D MAX

	Engineering

	180
	18
	C32
	AutoCAD 2D 

	160
	12
	C33
	AutoCAD 3D

	-
	24
	C35
	SAP 

	120
	16
	C11
	MS Project 

	-
	24
	C36
	Primavera 

	-
	24
	C27
	Mat lab 

	Programming & Database  & Tech. Support

	160
	24
	T02
	PC Maintenance 

	-
	36
	T04
	Networks

	-
	Ask
	P09
	Programming Diploma L1 & L2 & L3  

	-
	Ask
	MC
	VB.net & Java & C & C++ & C# & Java Script 

	
	
	
	SQL & Oracle 10g & PHP & ASP.net

	International Certificates

	175
	48
	
	ICDL 

	-
	60
	
	A+

	-
	Ask
	
	MCSE 

	-
	Ask
	
	MOS 

	-
	Ask
	
	CCNA

	-
	Ask
	
	MCAD 
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       عملــــــــي ///    أدخل علي كل ايكونة من ايكونات سطح المكتب وتعرف علي مكوناتها
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Part   I 


Studying Windows 





سطح المكتب Desktop :- 





Background


Icons 


Task bar





Open Windows  :-





My Computer


My Documents


My Network P.


Recycle Bin


Internet Explorer





Task Bar  :-





Time and Date


Sound Volume


Input Language





Start Menu :- 





Turn Off 


Log Off Username 


Run


Search


Settings


Documents


Programs





Search  :- 





For Files or Folders


On the Internet


For people





Settings  :- 





Control Panel 


Network Connection


Printer and Faxes  


Taskbar and Start Menu





Programs   :- 





Open program 


Programs Menu


App programs 





Index  :- 





Terminology


Shortcut Keys





Application Pro. 


برامج تطبيقية 





Database Pro.


برامج قواعد البيانات





Operating Systems 


أنظمة تشغيل 





البرمجيات Software 








مكونات الحاسب الآلي 








Hardware 


الأجزاء ألصلبه 





Human 


العنصر البشري 





Software 


برمجيــــــات 





Alt 





 ( Shift   





للبحث عن الملفات أو المجلدات





البحث في الانترنت





البحث عن أشخاص 





عملي ///    أدخل علي قائمة Search  وأبحث عن الصور أو الملفات عن طريق الاسم أو نوع الملف أو التاريخ 





عملي ///    أدخل علي قائمة Settings   وتحكم في لوحة المفاتيح والفارة والعرض والصوت والطاقة والطاقة  





عملي ///    أفتح البرامج الشائعة الاستخدام والبرامج الاخري المتخصص 





شريط الصيغة ( المعادلة )





نافذة ورقة العمل 





شريط المعلومات 





شريط الأدوات القياسي  





جزء المهام 





شريط القوائم





Work Book 





Sheet 1








Sheet 2








Sheet 3








256  Columns  








65536 Rows 








Cell





1





2





4





3





8





7





6





5





هوامش  الصفحة Page Margins





ظبط حجم الورق Paper Space 





ظبط اتجاة الورقة Paper Orientation 








لعمل لون أو خلفية للسمتند 


تنسيق Format  ( خلفية Background  ثنم أختر اللون الذي تريدة 





لعمل  علامة مائية Printed Watermark  


تنسيق Format  ( خلفية Background  ( Printed Watermark 


العلامة المائية اما ان تكون نص Text  موجود علي مكل صفحة او يكون صورة خلفية لكل صفحة ويفضل ان تكون ذات دلالة علي نوع المستند كشعار الشركة او لوجو المشروع او ما يرمز اليهم .











Clip Art  





إدراج صورة من ملف 





ممحاة





نمط الخط





حد خارجي





لون الحدود





عرض الخط





تنسيق تلقائي





لون التظليل





توزيع الأعمدة 





أدارج جدول 





دمج خلايا 





انقسام





فرز تصاعدي





اتجاه النص 





جمع تلقائي





رسم جدول 





عرض تقديمي فارغ 





باستخدام قالب التصميم 





باستخدام معالج المحتوي التلقائي التصميم 





فتح عرض تقديمي سابق





عرض عادي ( يظهر عند التشغيل )





فرز الشرائح ( إظهار الشرائح بشكل مصغر ) 





عرض علي الشاشة بالكامل 





لإظهار جزء الملاحظات مع العرض 





Slide Tabs


عرض تفصيلي





Slide Pane


الشرائح





Task Pane


جزء المهام





Notes Pane  


جزء الملاحظات





Drawing Bar 


شريط الرسم





Status Bar 


شريط المعلومات





شريط التنسيق


Formatting bar 





شريط الأدوات القياسي


Standard tools bar 





شريط القوائـــم 


Menu bar 





شريط العنـــــوان 


Title bar 
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عن النقر علي نص او فقرة  R.C تظهر قائمة مختصرة كما بالشكل بها العديد من الأدوات المتعلقة بتنسيق الفقرات ويمكن عن طريقها اختيار حركة مخصصة للنص أو الفقرة أو الصورة أو لشكل تلقائي ( تأثير دخول وتأكيد وخروج ) ، ويمكن أدراج ارتباط تشعبي للكائن بأي شريحة أخري أو جزء من الشريحة نفسها .


بعد الانتهاء من كتابة البيانات بعرضك التقديمي قم باستخدام الأدوات آلاتية في تنسيق الخط وعمل تأثيرات حركة لها وتنسيق الرسم والتحكم في اعدادت الحركة .





2





من قائمة عرض يمكنك التحكم بكافة الشرائح في نفس الوقت من خلال رئيسي ثم اختيار التنسيقات المراد تثبيتها علي كافة شرائح العرض بحيث تكون النموذج أو التصميم الثابت لكل الشرائح، ويمكنك التحكم في أنظمة الألوان وإظهار وإخفاء شريط المهام وأشرطة الأدوات وإظهار وإخفاء خطوط الشبكة والتحكم في طريقة العرض من اليمين الي اليسار أو العكس ، وعند اختيار رأس وتذييل الصفحة من الممكن ان نكتب عنوان رئيسي في كل شريحة وإظهار التاريخ والوقت ، وإدراج رقم الشريحة ، وتكبير وتصغير عرض الشرائح .





3





قائمة إدراج من أهم القوائم بالبرنامج من خلالها ندرج الشرائح الجديدة ونكرر الشرائح وندرج رقم الشريحة والوقت والتاريخ، كما يمكن إضافة تعليقات، وإدراج شرائح من ملفات أخري وإدراج الصور من ملف أو البوم الصور أو الإشكال التلقائية، كما يمكن عمل أشكال توضيحية من مخطط وإدراج مربعات نص للكتابة أو إدراج تخطيط بياني أو جدول أو كائن ( صوت أو صورة أو أداة تحكم ).


كما يمكن إدراج الأفلام والأصوات أو تسجيل صوت.





يمكنا عمل البوم صور فوتوغرافية عن طريق إدراج صورة ثم اختيار البوم صور جديد وتحديد الصور من القرص الصلب والتحكم في عدد الصور في كل شريحة ، والتحكم في شكل الإطار في حالة تعدد الصور بالشريحة الواحدة وكتابة الأسماء التوضيحية علي كل شريحة .





من قائمة تنسيق نتحكم في :





تصميم الشرائح وتشمل :


قوالب التصميم 


أنظمة الألوان 


أنظمة الحركة 


تخطيط الشريحة Slide layout


وذلك لاختيار تخطيطات النص واختيار العناصر التي تضاف إلي العرض ( الهيكل العام للشريحة )


الخلفية Background


يمكنك اختيار خلفية لكل شريحة أو لكل الشرائح وعمل تداخل وتأثيرات علي الألوان من خلال تأثيرات التعبئة .





4





5





من خلال قائمة  Slide Show أجراء العرض علي الشاشة أو عن طريق F5 , وبعد معاينة العرض مبدئياً يمكنا اختيار إعداد العرض للتكم في الشرائح التي ستعرض وطريقة تقدم الشرائح وطريقة العرض ولون القلم واختيار دقة الشرائح ، واذا انتهينا من الإعداد نقوم بالتمرين علي التوقيت حيث تعتبر أحدي الطرق التي يحدد  من خلالها الفترة الزمنية بين كل حركة وأخري وكل شريحة والتي تليها ويمكن المحافظة علي هذا التوقيت والعرض به  .


أنظمة الحركة Animation Schemes  


هي أحد عناصر تصميم الشرائح من خلالها يمكن اختيار تأثير حركة ينفذ علي كل نم الشريحة نفسها والنصوص الرئيسية بالشريحة وتطبيق ذلك علي كافة الشرائح. 


حركة مخصصة Custom Animation  


تختص بإضافة تأثيرات فردية النصوص أو الصور أو الإشكال التلقائية والتحكم في أعدادات كل حركة علي حدة من خلال النافذة التي تظهر أيسر الشاشة ( الإصدار العربي ) 


المراحل الانتقالية بين الشرائح Slide transition


الانتقال بين شريحة وأخري قد يمر تلقائي عن طريق النقر علي الفارة أو المسطرة أو أي مفتاح دون اختلاف بين انتقال شريحة وأخري لكن من خلال هذه الخاصية يمكن إضفاء تأثير علي الانتقال والتحكم بالتقدم بالشرائح ( لاحظ الفرق _تمرين علي التوقيت ) 


أخفاء شريحة Hide Slide 


قد يواجهني اثناء العرض مشكلة الوقت وان مقيض بوقت محدد من خلال هذه الخاصية يمكنا إخفاء شرائح محددة  لتخطيها عن العرض ، أو تحسباً لسؤال ما يظهر إثناء العرض فاخفي الشريحة إذا ما سئل هذا السؤال .


عروض مخصصة Custom Show  : لاختيار عدد من الشرائح للعرض فقط واختيار ترتيبهم الأمثل .











أزرار الإجراءات Action Buttons


 هي مجموعة من الصور الشائعة الاستخدام مثل السابق والتالي وتشغيل وإيقاف الصوت يمكنا من خلالها ضبط الإعدادات الخاصة بها لكي تسهل للمستخدم سهولة التنقل وتشغيل وإيقاف الأصوات وتشغيل الملفات بسهولة ويسر. 


تضاف إلي الشريحة الرئيسية !! 





تخطيط الشريحة





تصميم الشريحة





المراحل الانتقالية للشرائح





التحكم في الحركة المخصصة 
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السبعة محركات البحث الكبرى 





كيفية البحث بمصطلحات فريدة 





محركات البحث وكيفية عملها








Binaryegypt


com


eg





info@ binaryegypt.com





User@domain





info@binaryegypt.com





رشح من تحب لدورات اليوم الواحد المجانية للشركة من ضمن البرنامج الدعائي للشركة ومراكز التدريب به او الموقع الرسمي للشركة. من خلال الفيس بوك


أبحث والتحق :-  


Binary Egypt 


باينري مصر 





Binary Systems Company


Computer Education Centers & IT Solutions 





رشح من تحب لدورات اليوم الواحد المجانية للشركة من ضمن البرنامج الدعائي للشركة ومراكز التدريب به او الموقع الرسمي للشركة. من خلال الفيس بوك


أبحث والتحق :-  


Binary Systems Education centers


Binary Systems Centers  





Binary Systems Company


Computer Education Centers & IT Solutions 





Binary Systems Company


Computer Education Centers & IT Solutions 





Binary Systems Company


Computer Education Centers & IT Solutions 





رشح من تحب لدورات اليوم الواحد المجانية للشركة من ضمن البرنامج الدعائي للشركة ومراكز التدريب به او الموقع الرسمي للشركة. من خلال الفيس بوك


أبحث والتحق :-  


Binary Systems Education centers


Binary Systems Centers  





Binary Systems Company


Computer Education Centers & IT Solutions 





رشح من تحب لدورات اليوم الواحد المجانية للشركة من ضمن البرنامج الدعائي للشركة ومراكز التدريب به او الموقع الرسمي للشركة. من خلال الفيس بوك


أبحث والتحق :-  


Binary Systems Education centers


Binary Systems Centers  





رشح من تحب لدورات اليوم الواحد المجانية للشركة من ضمن البرنامج الدعائي للشركة ومراكز التدريب به او الموقع الرسمي للشركة. من خلال الفيس بوك


أبحث والتحق :-  


Binary Systems Education centers


Binary Systems Centers  





Binary Systems Company


Computer Education Centers & IT Solutions 





شركة باينري سيستمز مصر للتدريب وتكنولوجيا المعلومات


   دبلومات ودورات باينري مصر 





شركة باينري سيستمز مصر 


دبلومات ودورات باينري مصر 





شركة باينري سيستمز مصر 


دبلومات ودورات باينري مصر 





شركة باينري سيستمز مصر للتدريب وتكنولوجيا المعلومات


   دبلومات ودورات باينري مصر 
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